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Getting Started with Oracle Bl Publisher 11g

This tutorial contains the following sections:

Purpose Q
Time to Complete /\0)
Overview %

Prerequisites

& Getting Started with Bl Publisher @(

Logaing in to Oracle Bl Publisher and Navigating the Home Page

Browsing the Catalog and Viewing the Reports @
Setting Preferences \
Configuring the Data Sources Q

Defining a JDBC Connection
Configuring File Data Location
Defining a JNDI (Java Naming and Directory Interface) Conneg@
& Creating a Data Model Q'
Defining Default Data Source, and Output Options Q
Creating a SQL Query Data Set
Viewing the XML Output and Saving the Samp a
Creating a Report 8\&
& Building a Layout Using Layout Editor
Launching the Layout Editor and M@X:Grid Layout
Working with Charts
Adding a Data Table to theAsayd
Formatting the Data, and{[\v&nq with the Page Layout Features

& Scheduling a Report \S
Confirming thakﬁa%zduler is Configured

Defining D \\Destinations

Types of Supported Data Sources @%b

<</< Resqurces

+» YPurpose

Q\t This tutorial covers how to get started with Oracle Bl Publisher 11g to create simple reports based on Oracle
Database. Also, it teaches you how to create report layouts using the Layout Editor online, and how to
schedule reports.

Time to Complete
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Approximately 1 hour.

Overview

Oracle Bl Publisher is a strategic enterprise reporting product from Oracle that provides the ability to create

and manage highly formatted reports from a wide range of data sources. Oracle Bl Publisher is available as %\/
part of the Oracle Bl Enterprise Edition Suite and also as a stand alone reporting tool. Oracle Bl Publisher \
report formats can be designed using Microsoft Word or Adobe Acrobat, the tools that are easy to use, and

most users are already familiar with. Oracle Bl Publisher also allows you to create reports from different
types of data sources such as Oracle Database, Files, Bl EE, Web services, and Discoverer. @

Release 11g of Oracle Bl Publisher has enhanced, easy- to-use user interface (Ul), many enhan Q}e
features, and newly introduced salient features such as - Data Model Editor - a graphical user in for
building data models within the Bl Publisher interface; and Layout Editor - a design tool that blgs you to
create report layouts within the Bl Publisher interface.

In this tutorial you will be guided to create simple reports in Bl Publisher based on O@)atabase. You will
also be guided to work with the Layout Editor to create the layouts for the reports.

Prerequisites Q‘)Q
Before starting this tutorial, you should: @

1. Have access to Oracle Bl Publisher 11g or installed BI Pl@er 11g as stand alone or as part of Oracle Bl

Enterprise Edition 11g. é

Also, it is recommended to use the following versignsof borrowers - Internet Explorer 7.0 (or above), Mozilla Firefox
3.6.3 (or above).
2. Have access to an Oracle Databasellg @/ith the sample schemas HR and OE installed and unlocked.

The exercises in this tutorial use the &ld OE schemas included in the Oracle Database.

3. Have executed the Repository Cre tility ( RCU) scripts in Oracle Database 11g. This should be done before
installing Oracle Bl EE. RCU cxgi the BI Publisher scheduler repository.

Note: Bl Enterprise Editi EE) installer comes with these out of the box RCU scripts, that create the necessary
schemas and the reposi s in the Database for various components of Bl EE including Bl Publisher. You need an
Oracle 119 Databas@run these RCU scripts.

However, yu!@ablish a JDBC connection and create data models and reports through Bl publisher using both
10g and bases.

M
et%\%g Started with Bl Publisher
t\ is topic guides you to login to Bl Publisher and get started. It has the following subtopics:

’
Q\\ . Logging in to Bl Publisher and Navigating the Home Page
Q\ . Browsing the catalog and Viewing reports

° Setting Preferences

Logging in to Oracle Bl Publisher and Navigating the Home Page
Browsing the Catalog and Viewing the Reports
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Setting Preferences

Configuring the Data Sources
Types of Supported Data Sources
Defining a JDBC Connection
Configuring File Data L ocation

Defining a JNDI (Java Naming and Directory Interface) Connection 'é\’
Logging in to Oracle Bl Publisher and Navigating the Home Page O)O)b
1. Enter the URL for Bl Publisher in the browser window, which is of the format- %

http://<hostname>: <port >/xmlpserver/. For example- http:/Iocalhost:9704/xm|pserver/v \

This opens the Oracle Bl Publisher Enterprise login page- Q%

A\
ORACLE’ BI Publisher Enterprise

Flease enter username and password

Username

Password

Accessibility Mode [

| Sign In |

Y
\
'\ . Login as a user with Bl Administrator privileges.

’,
Q\\ When you login to Bl publisher, the Home page is displayed-
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B tome Caog

Create ...
@ Recent
ﬁ Report

i Report Job 0)0)%\

é
Data Model O)Q
More™ %\

Browse/Manage ...

™
0 Catalog Faolders %%
ﬁ Repaort Jobs @

B Repart Job Histary Q'\’

Get Started ... p)

ﬁ Download BI Publisher Toals *
® Help Contents
o,

Orade Technology Metwark

N

3. The Home page is a task-oriented,Cé zed workspace combined with a global header, allowing access to Oracle
Bl Publisher objects, their respectiv itors, and help documentation.

\
Observe the various secti héihe Home page ( greatly enhanced in 11g release to enable the users get started
quickly with Bl Publish ‘\

L]
For example you cz ‘Q\eé -

A .lx\;tbsection on the left that has options to help you create reports, data models, and other objects.
A se/Manage section on the left to help you browse and manage the catalog, jobs, and job history.

Get Started section on the left to help you get started with Bl Publisher, with links to various Bl Publisher
nline Help, and Oracle Technology Network.

3% A Recent section on the right, personalized to each user so that the users can open/view the reports that
(J 3 ve been accessed recently (when you login initially, you may not see any objects listed in the Recent section).

N
&
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Create ...

[—
e. Report Job

:
i Data Mode

More™

Browse/Manage ...

0 Catalog Faolders
ﬁ Repaort Jobs
% Report Job History

Get Started ...

ﬁ Download BI Publisher Tools *
® Help Contents

o,
ﬁ Orade Technology Metwark

-

Also, try the enhanced Search capabi%\“&\&enables you to search for objects by type.

S

ORACLE" BI Publisher Enterprise Al v

Create ...

E Report

ey
@ Mata Mnd=l

Feport Job

&
D
]

E New

Home | Catalog

Bs Open~

Al |
Falders !
Reporis

Data Models
Style Templates
Sub Templates

@ Recent

4 . On the upper right side you can see the links for the Home page, Catalog, drop-down lists New, and Open.

Signed In As

Note: All these features make the navigation within Bl Publisher easy for report developers and users.
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Browsing the Catalog and Viewing the Reports

1. Follow the steps listed here to browse the catalog and open a sample report (predefined).

Click the Catalog link in the Browse/ Manage section ( or Click the Catalog link found on the right side of J’?&e
page). %

Browse/Manage ... Qo)%
O Catalog Folders %\0)

@ Report Jobs

\
E) Report Job History Home Catalog
2. The Catalog page is displayed as a tree structure on the left side of the th the details on the right.

See that the objects such as reports, data models are organized int(%%rs.

ORACLE" BI Publisher Enterprise . © | Administration | Help | Sion
Catalog Home Catalog E tew~ B& Cpen ~ Welcome, administrator »
va@aﬂ:ﬁ ® ﬁv | Lacation Samples

| E Folders Data Models | Last Modified 10/9/0% 10:43 AM | Date Crested 10/2/09 10:48 2

Created By

Expand | Marev

Executive | Last Madified 10/3/09 10:48 &M | Date Created 10/3/09 10:43 AM
Created By

=] 3 My Folders ~
E ) Shared Solders
® E3 Components

2 Samples Expand | Morev
B £3 Data Models Financials | Last Modified 10/2/09 10:48 &M | Date Created 10/9/02 10:43 AM
E B Executive W Created By
E B3 Prandals Expand | Mare»

EE3 Human Resources Human Resources | Last Modified 10/5/09 10:48 AM | Date Created 10,905
10:23 AM | Created By

Expand | Maorev

Marketing |Last Modified 10/9/09 10:48 AM | Date Created 10/9/09 10:458 AM
Created By

Expand | More™

Sales |LzstModified 10/9/09 10:48 AM | Date Created 10/%/09 10048 AM |
Created By

Expand | Morev

Supply Chain Management | Last Modified 10/2/02 10:43 AM | Date Created
10/3/09 10:48 AM | Created By

Expand | Marev

< B
El Tasks

Select and ...
Ho item & sefected

BN EEEEE

Note: The Samples folder found in Shared Folders contains a set of predefined sample reports. You will open one of
\' these reports.

3. Also see the tool bar with New drop-down menu that enables you to create new reports, scheduled jobs, data models
and so on.
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4.

< B[ comporents

Catalog
ERENTR
DJI\}DMEF

Report %\/
Feport Jab %'\0
Data Model 0)

Style Template Qq
Sub Template %\0)

Note that the tool bar also has other options such as copy, cut, paste, and other optior@&an be used when
creating or managing the catalog objects such as data models, and reports. %

ORACLE" BI Publisher @

BV ODRE @Oooo

| = Folders L}g |

Navigate to the Human Resources folder in Sample@ displays all the objects in the Human Resources folder.)

»

11g Overview |Last Modified 3/16/10 2:48 PM | Dn
Expand | Marev

=l Folders

HE[3 My Folders

EIE! Shared Folders
B3 1 Overview

Crosstabs | Last Modified 8/16/10 2:423 PM | Date ¢
Expand | Morev

Data Models | Last Modified &/16/10 2:43 PM | Dat

HE[3 2. Functional Examples Evpand | More™
3 3. Analysis and Dashboards -
L ) eText | Last Modified /16,10 2:45 PM | Date Creat
E[3 4. Actionable Inteligence Expand | More™
HE[3 5. Performance Management ) ! o
) ) Executive |Last Modified 8/16/10 2:43 PM | Date
D &, Published Reporting Expand | Mare>

D 7. Server Features

[0 2. Source Specific Features
H[ 9. Other Features

3 Bl 5Cs Training BIP Labs

Financials | Last Modified 5/16/10 2:43 PM | Date C
Expand | Marev

Humap Resources | Last Modified 5/16/10 2:43 FI
Expala jMu:urEV

Marketing | Last Modified 3/18/10 2:48 PM | Date t

D Components, Samples Expand | Mare™

HEfg MmIsC E

H[7] Samples

PDF Optimization |Last Modified 3/16/10 2:48 PM
Expand | Morev

SIS T

You can also search for a report (or other objects) using some key word and view it. For example, in the Catalog
page, select the Reports check box from the Search drop-down list, and enter a key word in the Text field beside it.
In the example below, the search results in a list of reports that have "Sales" in name.
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CFolders

......... -

[l oata Models w
£ [

5. Click Open link below the Salary Report.

Location | [5hared Folders/Samples/Human Resources

Open | Schedule | Jobs | Job History | Edit | Marev

Flex Salary Report | Last Modified 3/16/10 2:48 PM %b‘

Form P11D-UK2004 | Last Modified 3/16/10 2:43 Ph
Open | Schedule | Jobs | Job History | Edit | Marev Q'\,

Form Veterans 2004 | Last Modified 3/16/10 2:48 P %
Cpen | Schedule | Jobs | Job History | Edit | Morev @%

Form W2 | Last Modified 3/15/10 2:48 PM | Date Cre:
Open | Schedule | Jobs | Job History | Edit | Marev @

Salary Report | Last Modified &/16/10 2:43 PM Datb
Oﬁen Schedule | Jobs | Job History | Edit | Morev

o

[k (e R IR (TR

-

6 . The Salary Report is opened in view he report data is displayed using the Default layout. All the predefined
layouts for the report are displayed. a: rent tabs.
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ORACLE" BI Publisher Enterprise il

Salary Report Home | Catalog | [ Mew ~

EI .................
[Department Al | bl {Emgloyee[ 1 | v o,

iFinanciaI Style \{ Pivot Table ¥\ Default @' Q> B
Salary Report
Name Job Title lManager Department Salary
Matthew VWeizs Stock Manager Steven King Shipping 8,000.00
Adam Fripp Stock Manager Steven King Shipping 8,200.00
Payam Kaufling Stock Manager Steven King Shipping 7,900.00
Shanta “ollman Steck Manager Steven King Shipping §,500.00
Kewin Mourgos Steck Manager Steven King Shipping 5,800.00
Gerald Cambrault Zalez Manager Steven King Zale= 11,000.00
Eleni Zlotkey Zalez Manager Steven King Zale= 10,500.00
John Ruz=el Zalez Manager Steven King Zale= 14,000.00
Karen Partners Salez Manager Steven King Salez 13,500.00
Alberto Errazuriz Salez Manager Steven King Salez 12,000.00
Den Raphashy Purchazing Manager Steven King Purchazing 11,000.00
Michael Hartztein Marketing Manager Steven King Marketing 13,000.00

You can also view the report usi y of the supported formats. Click View icon displayed on the top of the report
viewer towards the right. Q ed in the screen below).
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Home | Catalog

Signed In As welb

Department| Sales

Employee| Al Apply
Financial Style | PivotTable ™ Default ENIER

Salary Report B e

Ewcel
Hame Job Title lManager Department Excel2000
John Russell Zalez Manager Steven King Sale= @ PoverPaint
Karen Partners Zalez Manager Steven King Zales @ PowerPaint 2007
Alberte Errazuriz Zale= Manager Steven King Zale= ELJ coy
Gerald Cambrauft Zale= Manager Steven King Zale= @ Dat

ata

o

7 . Also, note the parameters defined in the report -Department and@

loyee, that display drop down lists for

department names and the employees working in the corresp@ji departments.

For example, when you select Finance as the Depart

Finance department.

m&(bﬂd the Employee list shows the employees working in
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ORACLE" BI Publisher Enterprise il

Salary Report Home | Catalog | [ Mew ~

EI .................
[Department Al | bl {Emgloyee[ 1 | v o,

iFinanciaI Style \{ Pivot Table ¥\ Default @' Q> B
Salary Report
Name Job Title lManager Department Salary
Matthew VWeizs Stock Manager Steven King Shipping 8,000.00
Adam Fripp Stock Manager Steven King Shipping 8,200.00
Payam Kaufling Stock Manager Steven King Shipping 7,900.00
Shanta “ollman Steck Manager Steven King Shipping §,500.00
Kewin Mourgos Steck Manager Steven King Shipping 5,800.00
Gerald Cambrault Zalez Manager Steven King Zale= 11,000.00
Eleni Zlotkey Zalez Manager Steven King Zale= 10,500.00
John Ruz=el Zalez Manager Steven King Zale= 14,000.00
Karen Partners Salez Manager Steven King Salez 13,500.00
Alberto Errazuriz Salez Manager Steven King Salez 12,000.00
Den Raphashy Purchazing Manager Steven King Purchazing 11,000.00
Michael Hartztein Marketing Manager Steven King Marketing 13,000.00

8. You can click Financial Sty

&
D
]

N

N

\

X~

s data for the Finance department using Financial Style layout:

\
@nd Pivot Table tabs to view the data in report using these predefined layouts.

The following screensih%
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Hame | Cataiog

Financial Style ' PwotTable | Defau:

=8 ¢

Brought Forward:

Employee Salary Report

Name Job Title Manager Department Name Salary

Manecy Greenberg Finance Manager Meena Kochhar Finance 12.000.00
Danied Faviet Accountant Nancy Greenberg Finance 5,000.00
John Chen Acccuntant Mancy Greenberg Finance 8.200.00
lamaed Selama Acgountant Hancy Grasnbeng Finance ¥,.700.00
Jomes M | Urmnan Accountant Mancy Gr berg Frnance 7.800.00
Luis Fopg ACcountant Mancy Greenbeng Finance £.500.00
TOTAL 51,800.00

NmessSiin 4l

N\

&
The followings screen displays data for the Sales departme %jng Pivot Table layout.

Q\”b

vl
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Salary Report
=
Department| Sales v | Emplayee| Al VIl anoiy
Finandial 5tyle  Pivot Table Default

Average Salary by Title / Department 50)0)

)
Sales Sales Average
Manager Representativ
e
Sales 12,200.00 8,356 .55 8,955.88
Average 12,200.00 8,396.55 8,955.588

Total Salary by Title / Department

Sales Sales Average
Manager Representativ
e
Sales §1,000.00 243 500.00 304,500.00

\

OQ\# \

Setting Preferences’\%
®

»>C |

1. To setthe erences , Click on the link Signed in as <user>, and select My Account from the drop-down list.
[aWA

.BI Publisher Enterprise Al

© | Administra

Signed In As administrator ~

Home ] Open ~

Catalog

2. This displays the Preferences screen with the General, My Group tabs/ links as shown in the screen below:
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My Account |E|

User ID  administrator
Display Mame  administrator

| General "\ Password | My Groups ,\/
ReportLocale | English (United States) v | \(b

UILanguage  |English (United States) v|
Time Zone | [GMT-08:00] Padific Time (US & Canada) s

Accessibility Mode () o, @ off /\O)Q

Help oK Cancel

You can set the Report Locale, Ul Language, Time Zone, and Accessj ﬁ&ode in the General Preferences

section. %

Report Locale- A locale is a language and territory cor‘l@e n (for example, English (United States) or
French (Canada)). Bl Publisher uses the report locale selection termine the template translation to apply , the
number formatting and date formatting to apply to the repol I@gta.

.Ul Language- The Ul language is the language your user interface displays in. The language that you
selected at login will be selected as the default. How: »you can choose from the languages that are available for

your installation through this option.

Time Zone - Select the time zone to ap@our reports. Reports run by you (this user) will display the
time according to the time zone preference stﬁ:t d here.

Accessibility Mode- Setting thi J will display the report catalog in a tree structure that is accessible

via keyboard strokes .
N

Note: If running Bl Publisher integ ith a Security Model other than Bl Publisher, these preferences may be
inherited from the other securim | and you will not be able to change these values.

3. Click the My Groups.ta%view a list of the application roles to which you are assigned. You cannot modify this list.

XA

_ My Account

Jser I weblogic
Display Mame  weblogic

[ General\i’ Hyﬁ'mms\

<<SJ authenticated-role
& BIAdministrator
\’ Elauthar

BIConsumer

Help (o] 4



R R I'TEC,,#ZOQ,NiIagiri Block, Adithya Enclave @8801408841 , 8790998182

To change your password, click the Password tab of the My Account dialog.

Note: Password tab is visible only when you use BI Publisher Security.

Configuring the Data Sources :\
Types of Supported Data Sources \0)5
Oracle Bl Publisher supports various types of Data Sources such as JDBC data sources (Oracle Dﬁ\q%se,

and other Databases), XML Files, Bl EE Reports (Answers), JNDI data sources, OLAP data sou%, usion
Application Data sources, Web Services, HTTP data sources, and Discoverer. \\

Before you create a data model based on these data sources, you need to configure ction to these

data sources first. In this topic, you will learn how to configure a JDBC connection t acle Database,

and also you learn how to define a File data source.

This topic has the following subtopics-

Defining a JDBC Connection @
Configuring File Data Location
Defining a JNDI Connection @

Defining a JDBC Connection

[ N

i | Administration | Help v

BS Open~ | Signe®In As weblogic >

R

This displays the Bl P\éher Administration page as shown below (Observe the Data Sources section in the screen below):
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Administration Home | Catalog

Eécg Data Sources E«ch System Maintenance

3 @ JDBC Connection @ Server Configuration %\/
@ INDI Connection @ Scheduler Configuration \’
@ Filz # Scheduler Diagnostics )

@ LDAP Connection
2@ QOLAP Connection

Runtime Configuration

5:3_-1 Security Center

@ Security Configuration @ Properties
@ Roles and Permissions @ Font Mappings
@ Digital Signature @ Currency Formats
ﬁ@ Delivery =3 Integration
I@ @ Delivery Configuration ‘LE a @ Oracle BI Presentation Services
@ Printer @ COracle BI Discoverer
@ Fax
@ Email
@ WebDAaY
@ HTTP
@ FTP
@ CLPS Server

2. Click the JDBC Connection link fou r the Data Sources section in the Administration page.
e
Eé& Data Sources )

3 @ JDBC Connection
2@ JMDI Connection
@ File
2 LDAP Connection
@ QLAP Connection

\
3. Th&lays the Data Sources page. In the JDBC section, click Add Data Source to create a JDBC connection to your
database.

/\
N
&
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E new~ Bs Open~

Administration Home | Catalog

Administration = JDBC
Data Sources
JDBC | INDI | File | LDAP | OLAP

Add ﬁtl:':ltil Source |

Data e Name Connection String De
EI2MHAdd Data Source jdbc:oracle:thin: @xdo-pm.us.oracke.com: 152 1:onc T
demo jdbc:oracle:thin: @xdo-pm.us.oracke.com: 152 1:onc I
Oracle BT EE jdbc:oradebi: (fdadvwmod505: 9703/ I

4.In the Add Data Source page that is displayed, enter the details as given belo&

Data Source Name - OE Q

Driver Type - Select a driver type to suit your Database (f %ple, you can select Oracle 10g or Oracle 11gto s
your Database). @
Database Driver Class - oracle.jdbc.driver.OracIeDriv%D ne a driver class to suit your Database)
Connection String - Provide the database connecti i

ils. For example hostname:port:sid.
User name - OE (Database user name) (\’

Password - OE (Database user password)

Do not click Apply or Cancel after defining the Itﬁe details. Click Test Connection.
AVaN
* Data Source Name |OE |
* Driver Type | Oracle 11g V|

* Database Driver Class ||:||'acle.jl:IIJc.OracIeDm-'er
{Example: oracle.jdbc.OracleDriver }
* Connection 5tring  |jdhc:oraclesthin:@myhost:1521:0rc|

* Username ||:|e |

Password |u |
[l use Proxy Authentication
Test CDI‘II‘IEﬁ_EiDI‘I |
L,
\

/<(/Note: To continue with this tutorial exercises, the sample schemas OE, and HR should be installed in your Oracle Database
\, mentioned in the Prerequisites. Else, you will not be able to define this JDBC connection.

5 If the connection to the database is established, a confirmation message is displayed indicating the success.

( As shown in the screen below).



&

N
&
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Then click Apply.
Administration = JDEC = Add Data Source

[El Confirmation

Connection established successfully. @
Add Data Source %

6 You can see this newly defined connection (OE) in the list of JDBC Data Sources. /\0)

Administration = JDBC

Data Sources %\\‘ L
IDBC | INDI | File | LDAP | OLAP %
Add Data Source Q\

Data Source Name

EISAMPLE %
= &

Q
5 &

0

Note: You can also set up the the default® ction demo to point to OE schema in your database, as the samples use this
connection. Then the demo connectiqs e used as the default data source for this tutorial too.

&\

Configuring File Da’ga@s%ion
S
1.BI Puinsher*i'@xrvb

ith a repository of various sample files and reports. These are available in Bl Publisher home.

To def@iﬁe data source, click the File tab in the Bl Publisher Administration page.

Cl&he demo files link to update the file location.
\
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Administration = File
Data Sources
IJDBC | JNDI | File LDAP OLAP

Add Data Source

Data Source Name Directory

El Sample App Lite Source Files [scratchfnpsomas/OBI_HOMEfinstances/instancel/bifoundation/CraclkeBlServerComponant/cors
El Server Source Files [scratchfnpsomas/OBI_HOMEfinstances/instancel/bifoundation/CrackeBlServerComponant/cors
dema files [scratchfnpsomas/OBI_HOME user_projects/domains/bifoundation_domain/config/bipublisher/re

o)
(If you want to create a File data source with a different name, you can click Add Data S%"r».\)

2. Define the top level directory which has all the sample files (repository). @
:\'\.

Administration = File > Update Data Source: demo files
Update Data Source: demo files

#
General
Data Source Mame  demo files
= Full Path of Top-level Directory |_.-'5cratch_.-'n|:|5|:|ma5_.-'DBI_HO[v1E_.-'L|5er_|:|r|:|ject5_.-'|:lnmain5_.-'l:|'rr'|:|L
Lisars can aoosss f =5 1N This cuneClony” and Sy SUDEneCciones.
Security
Dvailafie Jgiee Allam] Aol
=)
Move &l
) o
Move & v
=) X
Remaove
<)
Remowve A

&

ngs}ng this demo files data source, users can access all the files in the top level directory and also it's subdirectories).

N
&

Defining a JNDI (Java Naming and Directory Interface) Connection

Bl Publisher supports connecting to a JDBC data source via a connection pool. Using a connection pool
increases efficiency by maintaining a cache of physical connections that can be reused. When a client
closes a connection, the connection gets placed back into the pool so that another client can use it.
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Note: JNDI Connection concept is briefly introduced here, as you need to first set up the connection pool in
your application server and access it via Java Naming and Directory Interface (JNDI). Then, you can define
the IJNDI connection in Bl Publisher by entering the required fields in the JNDI connection definition page, so
that BI Publisher can utilize the pool to establish connections.

Creating a Data Model ’\/

In release 11g, Oracle Bl Publisher introduces the Data Model Editor, a graphical user interface for building %»
data models within the Bl Publisher interface. It enables you to perform the following tasks:

Create Data Sets - Access data from a wide range of sources: RDBMS, OLAP, WebServi
Analyses, XML files, Excel and others.

Query data — Build SQL or MDX queries to extract data from relational or muItidimensio%( LAP)
data sources. \
Structure data — Define master-detail relationships between data sets to group %bﬁ ultiple

levels to optimize document generation. %
Aggregate data — Create group level totals and subtotals. %
Customize data — Modify data field names to conform to business ter %{ porting

requirements.

Create calculations — Compute data values that are not stored in %%mrlying data sources that
are required for reporting.
Advanced tasks — Define parameters and lists of values (LO@ ers, and other advanced
elements as required by reports and report users.

In this topic, you are guided to create Data Model based on %ery using the JDBC connection you
defined in the previous topic. Also, you will learn how to ad meters and LOVSs to the data model.

Defining Default Data Source, and Output Options <</
Creating a SQOL Query Data Set @
Viewing the XML Output and Saving the Sampl t

N\
Defining Default Data Source, Output Options
Q OQ\k \
1. Note: Before startigg%:qc eation of Data Model, you will first create a folder to save all your objects such as reports,
data models and Q!

In the Home, rgclick Catalog link under the Browse/Manage section.
In the Cat page that is displayed, select the My Folders node, click the New icon on the tool bar.

~\
Catalog

R RRE R R

E[3 My Folders
[7] shared Folders

Select Folder from the drop-down menu to create a new folder.
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Catalog

G.BaiEC

“Repnrt | %\(b'\/

@ Report Job
Data Model

Style Template O)Q
Sub Template %\
. - . \
Enter Learn as the name of the folder, (optionally enter a description), and click Cre%
] \}Q

Create
* Folder Mame  |Learn
| ,:b

Description N

| Create M Cancel

(0

You can see that the folder gets listed Ln@ers.
O

2. Now, you can invoke the Datae’@geditor in one of the following ways-

From the Ho \@Create section, select Data Model.
From the Cat{m%age, click New icon and select Data Model from the drop-down menu.

e T

Create ...

N -
\, ata Model

More
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ORACLE BI Publisher

T R

E@@ HEDXR S§-
ﬁ Folder

@ Schedule
Data Model
StyIETemp@

E Sub Template

3. Observe the Data Model Properties page that is displayed on the right.
Select a Default Data Source (that points to the OE schema in your dat
data model.

s@). Optionally, add a description to the

Untitled Data Model

g Data Model
=l Data Model

Properties

Description
g Data Sets

g Event Triggers

Default Data Source +w | Refresh Data ¢

g Flexfisldz

BISAMPLE
demo

Cracle BI EE E§

[ Enable Scalable Mode

g L=t of Valuss

g Paramsters Cracle DB Default Packans

Database Fetch Size

g Bursting

Backup Data Source [~ Enable Backup Connection

" Switch to Backup Data Source when Pr
Data Source is unavailable

T Use Backup Data Source only

Ensure that in the XML Output Options, the Include Parameter Tags is checked, and the Include Empty
Tags for Null Elements, and Include Group List Tag check boxes are not checked.
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Home | Cata

Untitled Data Model

g Data Model
=l Data Model

Properties

Description
g Data Setz

g Event Triggers

g Flexfields Default Data Source w | Refresh Data |

g Ust of Valuss BISAMPLE
g Paramsters COracle DB Default Packans %qu
[ Bursting Datahase Fetch Size (Oracie BIEE

[ Enable Scalable Mode

Backup Data Source [~ Enable Backup Cannection

" Switch to Backup Data Source when P
E Data Source is unavailable

T Use Backup Data Source only

For defining the Default Data Source, you can alsQQﬁhe default demo data source to point to the OE
schema in your Database, and use it.

Also, note that on the Properties page you ca &’Qnany options in addition to specifying a default data
source. For example, you can specify DB defau e, and DB fetch size (the data engine’s default is 300),
XML output options based on what XML tags yg@ uire in the resulting XML output.

O

4 . To save the data model with a name, g%'gle As icon found at the top right corner of the page.

Return @- | E |®3~
=l

A\

Navigate to the foIde’tQ’;l ou want to save the data model object ( Learn in this example), enter an appropriate
name for the Data ng , and click Save.

N
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"Save As E)

| catalog
El My Folders

Itl Subject Area Contents ,\,
El _temp @
mla Drafts %
Itl Learn %

El Shared Folders

B3 common
[ Components IEI
[3 PaintDemo
[T samples

Marme
Emp_DM
Description

Save Cancel

0\}'
<(§\
X
D
Creating a SQL Query Data Se@arameters and LOVs
N

1 From the Data Model tas%\gn the left, select Data Sets.

.\S\
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o on G

g Data Model

E Data Model f\,
- boasets. NS
g Ewvent Triggers q%

g Flexfields Qq
g List of Valuez /\%

g Paramsters

g Bursting

g Data Model

B Data Model \r@/

= Data Sets. | /7 X

g Ewvent Triggers 3 SQI:{%:EW

g Flexfields i MDrery
Oracle BI Analysis

g Listof Values
g Parameters

g Bursting

oN

qte a query.

D
]

E View Object

Web Service

LDAP Query

XML File

E Microsoft Excel File

Cracle BI Discoverer
@ HTTe (ML Feed)

\
31In We‘@ate Data set -SQL dialog box that appears, enter an appropriate hame for the data set, accept
% ult data set option (as you have already defined it in the Data Model), and click Query Builder to
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" Create Data Set - SQL

* MName |

Data Source

(O Default Data Source

® Fisfresh Dats Sounce List

* 501 Query
Load Metadata Information

Qv

N
| Query Builder | f)%
W)

4 The Query Builder window appears displaying the OE schema objects on t

= Query Builder - Windows Internet Explorer,

Click DEPARTMENTS, and EMPLOYEES tables to add them to the @
AN

<b‘0'
%b%e.

nvas on the right.

schema | o B | model Conditions SaL Resuits Le

Search | _}:’ |

%  DEPARTMENTS = X 5 EMPLOYEES =

ACCOUNT_MANAGERS # | []DEPARTMENT ID 7% [] EMPLOYEE_ID Paq
ACTION_TABLE

BOMBAY_INVENTORY [] DEPARTMENT _MNAME A [] FIRST_MNAME A
CATEGORES_TAB ] MANAGER _ID Pig ] LAST_MAME A
COUNTRIES

CUSTONERS ] LocaTIon_ID g [] Eman Fiy
CUSTOMERS_VIEW ] PHONE_MNUMBER. | A\
DEPARTMENTS P HIRE_DATE =
EMPLOYVEES

INWVENTORIES [] 108_1D A
JOB_HISTORY — n.
JOBS

LIMETEM_TABLE

&

4

5 Now, define a join between these two tables as follows:

. Click the box beside DEPARTMENT _ID column in the DEPARTMENTS table.
Similarly click the box beside DEPARTMENT_ID column in the EMPLOYEES table.
(These boxes, when marked for joins turn light gray. )
Also note that a fine line joining the tables appears in the Model canvas.

s
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Model Conditions SQL Results [10 |s | save | | cancel |

%,  DEPARTMENTS = X 2
[ ] CEPARTMENT ID &9 {b

EMPLOYEES i EEF.. '\,

] PHOME_MUMBER | &4

[*

[] DEPARTMENT MAME A

[] HIRE_DATE = O>
[[] MANAGER_ID P8 0)

[] 10B_ID A Q
[]ocaTion_ 1D G 0)

] saLary g %

[ commISsSIoN_PCT P

[] manaGER_ID g

g :

S

6 Select the following columns from the tables (by selecting the chec@% beside the column names):

[] cEPARTMENT _ID

. -Select DEPARTMENT_NAME from the DEPARTMENTS table
-Select FIRST_NAME, LAST_NAME, HIRE_DATE, and SALARY c6ftmns from the EMPLOYEES table

(See the screen below)

N

. Change the aliases for the columns as below:

Model Conditions SOL Results |10 |+ | save | | cancel |
%,  DEPARTMENTS |« X 5 EMPLOYEES & X
[] DEPARTMENT_ID |78 FIRST_MAME A %
DEPARTMENT_MAME |24 LAST_MNAME A
[] MaMNAGER_ID g []emal A
[ LocaTIoN ID &g [] PHOME_MUMBER. | &4
HIRE_DATE =
[] 10B_ID A i
SALARY g
% — - o

] ~N
R
<,\<<fCIick the Conditions Tab . Change the column names and remove "_" to have more appropriate aliases.

&

DEPARTMENT_NAME to DepartmentName

FIRST_NAME to FirstName
LAST_NAME to LastName
HIRE_DATE to HireDate



&
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SALARY to Salary

Model Conditions SQL Results [ 10 |s

Column Alias

AW DEPARTMENT_NAME | DepartmentName |

W FIRST_MNAME |FirstNamE | Q
RN LAST_NAME |LastHName | (%\0)

R % HIRE_DATE 'HirsDate |

RV SALARY Salary |

K N
S

8 Also, type "IN (:P_DNAME)" in the Condition field for the depart@ ame column, as shown in the
. screen below . This will define a parameter P_DNAME on the d@/a nt name column.

A\
Model Conditions SOL Results [10 |w | save | | cancel
Column Alias Object Conditic
AW DEPARTMENT_NANE |DepartmentNane | DEPARTHMENTS  |IN (:P_DNAME
AN FIRST_NAME FirstNane | EMPLOVEES | 7
R LAST_NAME LastHame | EMPLOVEES |
AW HIRE_DATE HireDate | EMPLOVEES |
AW SALARY Salary | EMPLOVEES |
RN
Note: The I ondition is being used here for the parameter to accept All or Multiple values for the
depa ame column.

T@ses and display names can be changed in the Data Model page, either in the Diagram or in the
Struk

ture too:
N
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B
ERRE

Edit Fmpe.tres DEPARTMENT_MAME

= i Global Level Functions

Drop here for aporeate functon || | DEPARTHENT_NAKE [abe] Column Mame  DEPARTMENT NAME '\,
HIRE_DATE BE o . %
Alias DEPARTMENT NAME
EMPLOYEE_NAME s LAk THMEN] " heti — %\
SALARY [  ®l| *Displeyname [DEPARTMENT NAME >>

!| Drop here for agorenate funchion |

*Data Type  String

Sort Order | Mo Ordering

Vahee TF Nl |

| Hel . ok llute

9L

Table View | Cutput
KML View Business Yiew
Data Source ¥ML Tag Mame Sorting |'l.|'alue If Mull| [Display Name
[=IRepart Data
[ElData Structure DATA_DS
=l Emp_Dataset G_1 G_1

[abe) DEP ARTMENT MAME |DEPARTMENT_NAME o DEPARTMENT NAME
EHIRE_DATE HIRE_DATE % HIRE_DATE L%
8 EvpLOYEE NAME  ||EMPLOYEE_NAME o) EMPLOYEE_MNAME
B9 5 L ary SALARY £ SALARY

\%Qa

9 Click Resul \ee how the query results appear in Query Builder.This will prompt you to enter a

. departm

Explorer User, Prompt

Script Prompt;

% e for the parameter, enter Sales and click OK.

Pleaze enter a value for parameter 'p_DHAME".

Cancel |

ISaIesl

View results. Click Save to save the query.
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Model Conditions S0L  Results |10 | Save Cancel ||
| Department Firstlame LastName HireDate | |
..... 53|EE Jnhn.......... F‘;.I;;;E-E" 195@_1.]_.31.3.].].].].3.]
Zales Karen Partners 1557-01-05 00:00:00.0
Zalez Alberto Errazuriz 1957-03-10 00:00:00.0
Sales Gerald Cambrautlt 155959-10-15 00:00:00.0
Zales Eleni Zlotkey 2000-01-28 000:00:00.0
Sales Peter Tucker 1957-01-30 00:00:00.0
Sales David Bernztein 1957-03-24 00:00:00.0
Sales Peter Hall 1957-08-20 00:00:00.0
Zales Chriztopher  Olzen 1958-03-30 00:00:00.0
1l Sales Wanette Cambrault 1958-12-05 00:00:00.0

1 This takes you back to the Create Data set -SQL dialog box, and @rve that the query you created is
0 reflected in the SQL Query area.
. Enter an appropriate name such as Emp_DataSet, and click add this data set to your data model.

\D

Create Data Set - SQL (]

* Hame |Emp_DataSet |

Data S0Urce (&) pefault Data Source
O Refresh Detz Sownce List

* 501 Query | Query Builder |

select "DEPARTMENTS" . "DEPARTMENT MAME" as "DepartmentName™,
"EMPLOYEES","FIRST NAME™ as "Firstclame",
"EMPLOYEES"."LAST NAME" as "LastName",
"EMPLOYEES"."HIRE DATE" as "HireDate",
"EMPLOYEES"™."SALARY" as "Salary"
from "OE"."EMPLOYEES" "EMPLOYEES"™,
"OE"."DEPARTHMENTS" "DEPARTMENTS"

where  "DEPARTMENTS"."DEPARTMENT ID"="EMFLOYEES"."DEPARTMENT ID"
and "DEPARTMENTS"."DEPARTMENT NAME" TN (:P DNAME)

Help QK Cancel
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1 A message asks whether you want to create a bind variable. Click OK. to create the parameter
1

Windows Internet Explorer

\?’) Do you want to create a bind parameter ¥ : P_DMAME %\/
[ QK ,I; [ Cancel q

g Data Model
E Data Model %%v
= Data Sets b‘Q
Emp_DataSet Q'\’
g Event Triggers %%
g Flexfields @
g Listof Values Q
[ Parameters Q\:§
= P_DEME (</Q

[ Bursting

Every time you make changes to the D \a del (changes to the data set, adding parameters or any
other changes), click Save icon (fou e top right corner) to save the Emp_DM data Model .

&\

1 In the Data Model pane, ¢ \@t of Values node. In the List of Values pane click the the + sign to
2 Create new List of Valuges?

| S
Select the foIIowingngi ns:
E \epName as the Name of the LOV

leCt SQL Query as the Type from the drop-down list
ure that OE is selected as the Data Source

,§(\/ lick Query Builder to define the query that returns department names for the LOV

ve the Data Model.
<&
A
&
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= Data Model .
List of Values
= Data Model
Data Set= * x
=] Fhame Tvpe Data 5S¢
() Emp_Dataset MDeptame  l50L Query v

g Event Triggers

N
o Flexfields >§b

g Listof Values

New List of Value 1: Type: SQL Query

g Parameters

options [~ Cache Result
SQL Query

0= P_DNAME

g Bursting

7

3 O

. Query Builder - Windows Internet Explorer

Schema |DE Model Conditions S0L Results Car

Search | )-)

A DEPARTMENTS =~ X
ACCOUNT_MANAGERS ~ [ DEPARTMENT ID 786
ACTION_TABLE
BOMBAY _INWENTORY DEPARTMENT_NAVE A
CATEGORES_TAB ] MaNAGER_ID 7ag
ESE:;E':S =7 ] LOCATION_ID Pizg
CUSTOMERS_VIEW :
DEPARTMENTS
EMPLOYEES, _

Clic %%J\save the Data Model. The query for the LOV should look like this:
X

’\é Options [T cache Result
Q\\, SQL Query ——
N

select DEPARTMENTS.DEPARTMENT_MAME as DEPARTMEMNT _MAME
from OE.DEPARTMENTS DEPARTMENTS




R R I'TE C »,#209,Nilagiri Block, Adithya Enclave @8801408841 , 8790998182

1 Now, set the properties for the P_DNAME parameter to use this LOV:
4

" Select P_DNAME parameter listed under the Parameters node.

Enter Default value as * (the character star) , and select Menu as the Parameter Type (the default
parameter type is Text).

Parameters gb\

+ X

*Mame Data Typ Default Value Parameter Type

N
5 Ensure that Multiple Selection, Can select all, and All Values P ptions are selected.
. (These options allow you to select all / multiple values for the dep nt.)

1 Ensure that DepName is selected as the List of Values for the paral

Also, change the Display Label to an appropriate one like- Deps%ent:

r
Parameters

+ &

*Name Data Typ Default Yalue Parameter Type

=1
P_DNAME
Menu Setting
Display Label |Department:
List of Values |DE|:|NE||T|E i

Opﬁl:nnsl [v Multiple Selecﬁunl

,\é
N
&

" MULL Value Passed [* Al Values Passed

™ Refresh ather parameters A%change

Click Save to save the Data Model.

1 You can edit the query manually further to concatenate Last Name and First Name columns as Employee
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6 Name. Edit the query to look like this:

Select DEPARTMENTS.DEPARTMENT_NAME as ''Department Name',

EMPLOYEES.FIRST_NAME |] ° "] |EMPLOYEES.LAST_NAME as "Employee Name',
EMPLOYEES.HIRE_DATE as "Hire Date",

EMPLOYEES.SALARY as Salary f‘\/
from OE.DEPARTMENTS DEPARTMENTS, C%D
OE.EMPLOYEES EMPLOYEES \
where DEPARTMENTS.DEPARTMENT__ID=EMPLOYEES.DEPARTMENT_ID c{)

and DEPARTMENTS.DEPARTMENT_ID IN (:P_DNAME) %%

Click OK and save the data model. /\O)Q

The query should look like this in Query Builder: %

Edit Data Set (%]

* Name | Emp_DataSet

T Data S0UCE (%) pefault Data Source
& Refresh Data Source List

* 50L Query Query Builder
zelect "DEPRRTMENTS"."DEPRRTMENT MNAME" as "Department Name",

"EMPLOYEES"."FIRST NAME" v "EMPLOYEES"."LAST NAME"
azs "Enployves HName™,

"EMPLOYEES","HIRE DATE" as "Hire Date",
"EMFLOYEES" . "SALARY" as "Salary”
from "COE"."EMPLOYEES"™ "EMPLOYEES™,
"OE"."DEPARTHMENTS" "DEPARTMENTS"
where "DEPARTMENTS"."DEPARTMENT ID"="EMPLCYEES","DEPARTMENT ID"
and "DEPRRTMENTS"."DEPRRTMENT MNAME" IN (:F_DNAME)

£ | L#

Help OEF Cancel
M

-

\
Nott@e you edited the query manually, you will not be able to edit in the Query Builder.

&

’

Qg\ Viewing the XML Output and Saving the Sample Data

1. You may have observed that In the current version of the Bl Publisher, you can preview the XML data for the data
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model.

Click the XML icon (found at the right top corner of the page), to see the XML output for the data model you defined
in previous topic.

V
7w o

Note that All is selected for the Department parameter (as this is the default value ). Q%

Select All for the number of rows, and click Run to see the XML data output for all the dep /\ts:

\
( A portion of the XML data is displayed here in the screen) bg\'

o (e

=?xml version="1.0" encoding="UTF-8" 7=
<l-- Generated by Oracle BI Publisher 11.1.1.3.0 -->=
- <DATA _DS=
«P_DMNAME =[Administration,Marketing,Purchasing,Human
Resources,Shipping,IT,Public
Relations,Sales, Executive,Finance, Accounting, Treasury, Corporate
Tax,Control And Credit,Shareholder
Services,Benefits, Manufacturing,Construction,Contracting,Operations, IT
Support,NOC,IT Helpdesk,Government Sales, Retail
Sales,Recruiting,Payroll] </P_DMNAME =
- G 1=
<DEPARTMENTMAME =Administration </DEPARTMENTMNAME =
<FIRSTMNAME =Jennifer</FIRSTHNAME =
L ASTHAME >Whalen </ LASTHAME =
<HIRECATE=1987-09-17T00:00:00.000-07:00 </HIREDATE =
SALARY >4400 </ SALARY =
/G _1=
- =k 1=
,\<(/ <DEPARTMENTMNAME =Marketing </DEPARTMENTHNAME = [

N

Q\t 2 . To save this as sample data, click the Open Menu drop-down list icon, and select Save as Sample Data.
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Return = @
Export XML
Save As Sample Data

Get Data Engine Log

You can see that the sample.xml is listed in the Sample Data section of the Data Model ( as shown t@

)
I

=S

1 Data Model
=i Data Model

g Data Setz
Emp_DataSet

g Ewvent Triggers

g Flexfields

g List of Values
Dephame

g Parameters
EF P_DHAME

g Bursting

"\Ww

Properties

Description

Default Data Source

Cracle DB Default Packans

Database Fetch Size

Backup Data Source

¥ML Qutput Options

¥ML Tag Display

Attachment

Sample Data

Schema

demo

» | Refre:

[~ Enable Scalable Mods

[~ Enable Backup Connection

L Switch to Backup Data Source when Primal
Data Source is unavailable

L |Jse Backup Data Source only

[T Indude Parameter Tags
[ Indude Empty Tags for Null Elements
[~ Indude Group List Tag

| Upper Case

sample, xml

EY

by

Delete

&‘e: It is very important to save sample data for a data model, else when creating Layouts, the previews do not

You can select various values (multiple/ single) for Department to see the data. You can also restrict the number of

’\QSJabpear correctly.
N

&

rows that you want to see:



&

A

R R I'TE C »,#209,Nilagiri Block, Adithya Enclave @8801408841 , 8790998182

All

Al QO)

Administration
Marketing
Purchasing
Hurman Resources
Shipping

T &
Public Relations %%

Execu b‘Q
Finance \
Accounting Q
Treasury %
Corporate Tax %

Contral And Credit

Shareholder Services

Benefits

Manuhcmring AQJ
Canstruction (}’b

Contracting
Operations Q
IT Support <(,

MOC

IT Helpdesk @
Government Sales . \Q
Retail Sales b‘\\'

Recruiting
Payrall ~

also cr'e\/ ple layout using Layout Editor, and edit parameters.

\
/\%ﬂte: The steps in this topic are all continuous, so do not close any window or logout from Bl Publisher
, \unless you are asked to do so.

In this tcip@;?ﬂn to create a report using the Data Model that you defined in the previous topic. You
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1.

If not logged in, login into Bl Publisher, and go to My Folders> Learn folder in Catalog pane.

Click New (found at the top left corner of page) to see the drop-down menu and click Report to create a new report.

Catalog
AT o\

| N
[ Folder %
_ g 090’0)
Reportdo %\

Data Model

\
Style Template %vg
Sub Template Q%
2 . Navigate to My Folders> Learn. Select Emp_DM data model and clif@n.
N
Open (%] |

! |Fﬂtﬂ|ﬂ§l | Emp_DM
EHE3 Shared Folders
|:| Components
#-F3 samples
EHE My Folders
ElB Learn

B3 ~administrator

| Open I\_J Cancel

It displays the options to create, use a shared template, or upload a report layout.

Select Blank (Portrait) under the Basic Templates section to create a simple report layout.
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ORACLE" BI Publisher Enterprise
" Draft - Sep 2 2010 4-43-25 PM
._Data Model Emp DM1 q- @

Catalog | [ Mew ~

Hormne BS Open ~ | Signed In As weblod

(2] parameters | Properties |G vewReport | [

Basic Templates \,
)
Blarmk Elank ‘Hsader Headar
(Portrait) {Landscape) and and
Footer Footer
{Porirait) {Landscapea)
Shared Templates
J J J J J J ]
it a. ol [N il . il . il el il il e |
Orade Oracle Chart Chart and Dashboard Mobie Table
Confidential Farm Table Appie
= Letter - Fhone
Langscape Portrait

Upload or Generate Layout

Upload RTF, PDF, Excel, Flash, X5L
Styleshest, or eText template fle.

? %

Generate RTF lavout bazed on
selected Data Model,

N
R
Note: You can defj) \_ayout for the report at the time of creating report, or create it at a later point of time.
Creating repor}b ts using the Layout Editor is covered in detail in the next topic.

L]

N

3. This Layout Editor, with a blank page:

RV
&
D
]
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ORACLE BI Publisher Enterprise - 4!

0 | Administration

B& Open ~ | Signed In Az web

Draft - Sep 2 2010 4-43-25 PM : Untitled

= Data Source 9@ E Y | msen [Tragelayost|

£ 3 DATA_DS Retwn || [} B
i b P_DMMAME E? \/
BB 6.1 Components Page Slements )

i ] DEPARTMENT NAME
- ] EMPLOYEE NAME
- [E HRe DATE | €3 Repeating Section 6 Text Item € Gauge [ 1mage (2] Total Pages
LW sALARY -

[ &

| & Leyout Grd B Data Table [l chart BA Pivot Table | =T Page Bresk [#] Page

E
|
|
|
|
i

@

4. Click Insert > Data Table from the menu to insert a data t;@n the layout page.

Draft - Sep 2 2010 4-43-25 PM : Untitled Home | Catalog | [ Mew ~ B Op

=l Data Source 9 @ | ¥ i | i Insert || Page Layout
B (£ DATA_DS
oo [abe] P_DMAME Ll
ElEI 1 Components
-~ [dhe] DEPARTMENT NAME Layout Grid EA Data Table |l chart BB pivot Table
- [abe] EMPLOYEE NAME ‘“
E HIRE DATE t"ﬁ Repeating Section #be T Ttem 623 Gauge @ Image
Lo 199 SALARY
N o
Q\ 5. Select and drag the elements in the following order from the Data Source pane to the [Drop a Data Item Here] area
Q\ of the table:

DEPARTMENT_NAME
EMP_NAME
HIRE DATE
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SALARY

Table

Data Source D olBED B

= DATA_DS Return
i p_prave _ e
- E 61 Select Rows to Display Filter Conditional Formatting )
: DEPARTMEMT MA ! Bl
Select ~ - i Filter Highlight
EMPLOYEE NAME b o
E HIRE DATE x Delete ~ |" Manage Filters ¢~ Manage Formats

[Drop a Data Item Here]

N
As you drag an element, position each successive iten@’&gﬂy to the right of the previous element and release to
create each column, so that the data table, after zjggg | the columns it looks like this:

5% M| @ [TEESTTREERE | Table ColumnHeader |

dect Font  plignment Greuning

slect - | Tahoma vlgpt - ".;E;-;F=|: Mo Grouping =

glste * fET-I_[LT_m ‘&: E EE—QF_E—IE Subtotals
150 2

100 00 250 5L isa =00 450 30 550 G00 G50 700 750

| DEPARTMENT NAME [EveLOYEENAME  |HREDATE [saLARY I
Admmistration Jennifer Whalen 185 7-00-1TT00:00:00.000-07:00 4400
Marketrg Michae! Har tsbein 1996-02-17700:00:00.000-08:00 13000
Marketrg PatFay 1957-08-17T00:00:00.000-07:00 000
Purchasing Den Raphaely 1954- 12-07T00:030: 00,000 -08:00 11000
Purchasing Alexznder Khoo 1925-05-18700:0:0:00.000-07:00 3100
Purchasing Sheli Baida 1997-12-24700:00:00.000-08:00 2900
Q" Purchasing Sigal Tobias 1957-07-24T00:00:00.00@-07:00 2800
&% Purchasing Guy Himuro 1993-11-1 5700000 00. 003 -0E:00 2aid
\, Purchasing Karen Colmenares 195%-08-10700:00:00.000-07:00 2500
% Human Resources Susan Mavris 1984-05-07T00:00:00.000-07:00 6500
Q\ BE4401

6. Click the Save icon found on the top right corner to save this layout.
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Enter Default Layout as the name of the layout, and click Save.

Save Layout @

Layout List
Qv

Layout Mame: |Defau|t Layout |

Locale: | English {United States) V|

Help Save J|.,.q Cancel

&

7. This brings you back to the Layout Editor. @

Click the Preview icon drop-down list (highlighted in the sch%’to preview the data in Interactive format (this is also

the default format).
O

I @ | 3 E @ v I Insert I Page Layout l
d 8 |I'ItEFEE'ti‘-’E%
B2 Lavout Grid =22 W AT ivot Table
e PDF
fﬁ Fepeating Section  #5 @ — mage
A s [%] Excel 300 ?
PowerPoint
PowerPoint 2007
DEPARTMENT Naj B FO LOYEE MAME
Administration W XSl ifer Whalen
Marketing @. XPT ael Hartstein

-

S
&
D
R
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Ve 4| @ Interactive Viewer

Dt v B - deh - [hPege - £ Tock

| DEPRRTMENT NAME EMPLOYEE NAME HIRE DATE SALARY
| ackmiristration Jennifer U[J5art Ascending 1587-05-17T00:00:00.000-07:00 3300 #%
| Macketing Michae! 1|50t Desoending 1996021 7T00:00:00,000-08:00 13000 \/
I —1[v](5elect A1) = )
| Marketing Pat Fay [#]Jennifer Whalen = [F997-0E-17T00:00:00.000-07:00 S000
Purchesing Den Raph [W]Michael Hartsten 1994-12-07700:00:00.000-08:00 11000
I 5 [#]PatFay .
Purchasig Aexande 199505~ 18T00:00:00,000-07:00 3100 |
. = [#loe Raphaely z =
| Purdhasing Sheli Bad memp,;'ﬂ- Koo 1997 12-24T 0000000, 000 -08:00 2000
| Purchasng sigal Tobi| L4 Snel Baid 1997-07-24700:00:00,060-07:00 2500
[#]5igal Tobias o
| Purchasing Guy HimuEalm s ¥ l998-11-15T00:00:00,000-08:00 o0
| Purchasing karenco| LK ][ Caneel |finc0.08-10m00:00:00.000-07:00 2500 ||
Human RESOUrges Susan Mavris 1994-05-07T00:00:00.000-07:00 6300
sa4a00 |

Note: You can perform sorts and selection interactively here. Close the I@ive Viewer.

NJ

8. .Click Return in Layout Editor to return to the Edit mode of the r@

9.

Observe the various links on this page that will help you e
the report. You can also display the layouts as Thumbnai

+» O\

ORACLE" BI Publisher Enterprise

Home

Catalog

B new~

BE Open ~ | Signed In As weblogic ¥

e data model, parameters, properties, and layouts for
as a List.

[Date Model Emp oM | A | parameters [z Properties & view Report | 'E_EIJ@

|‘u"iewThumhnaiIs | '-a'iewalist|

|+ Add Mew Layout |

JI ol

Default Layout
[Edit | Properties | Delete |

Note: Parameters link is displayed, only when the data model you selected for a report has parameters defined.

Click Save icon (found at the top right corner of the page) to save the report. (You can also click Save As icon ).
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= BL@E

Navigate to My Folders> Learn. Enter Employee Salaries By Department as the report name and click Sa\%\/

Save As [ OO\

| Catalog | Emp_DM
H-E3 Shared Folders

EHE! My Folders
! M-F3 Leam
E-E3 ~administrator

Mame
Employee Salaries by Department
Description

| Save [ Cancel
e

&\‘

10 . Click the Parameters Ii@@t shows the details for the parameters. You can make changes to the parameter
values. Also, you can'% how or not to show the parameter in the report.

Clear the Shy&@ box not to show the parameter.

Note: Th@%n parameters are edited here not to show them in layouts. (This is not mandatory, but this is being
done tQ'depict all the data in the layout graphs that you will create in the next topic.)
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'Parameters (]
Show Name Display Label Default Value Type HMultiple
% P_CMAME  |Department: All % ||Menu  False
Partmeters Display per line |3

. Help oK Cancel
(bU
L
>

Building a Layout Using Layout Editor, .Q(J

report layouts from within Bl Publisher interfa Layout Editor provides an intuitive drag-and-drop
interface for adding common components o% port layout from within your web browser. The Layout
Editor uses the sample data in the data m immediately populate your layout components with report
data during design-time. It also provide advanced features to fully customize your reports.

Release 11g of Oracle Bl Publisher introduces an E@e Layout Editor, a design tool to create and publish

The Layout Editor provides a new_Ifjteractive output type in addition to output types like PDF, RTF, Excel,
PowerPoint, and HTML. Inte output enables lightweight interactions with the report data from within
the browser such as Excel-likgfjltering and sorting of tabular data with fixed headers and footers

In this topic, you will a layout with graphs and using the Layout Editor, for the Employee Salaries by
Department repq\ u created in the previous topic.
N

Launching the Layout Editor and Adding a Grid Layout

Qh‘&rts

a Table to the Layout

ng the Data, and Working with the Page Layout Features

oY
'\<?aunching the Layout Editor and Adding a Grid Layout

1. Click Return to return to the Edit mode of the report. (If the report
Now, click Add New Layout link to create a new layout for the report.



R R I'TEC »,#209,Nilagiri Block, Adithya Enclave @8801408841 , 8790998182

ORACLE" BI Publisher Enterprise

Catalog | & New v Signed In Az weblogic ~
Data Model  Emp_DM Ck (3] parameters Pmperﬁes 'l.n"lew Report | E_EIJ @
View Thumbnails | View a list '\/

|+ Add Mew Layu:uut| §b\

Home

.

.

E

Default Layout
Edit | Properties | Delete

AQ’W

2 . The Layout Editor is invoked, and displays the availatﬁ\'%mc and Shared templates (templates for report layouts)
to choose from. Q

AN

Layout Editor
Loading
EPI]I]I]I]I]I]I]I]I]I]I]I]I]I]I]EI{IJI(I}Q

\\
It displays t \@ to create, use a shared template, or upload a report layout.

Click @k\ Portrait) from the Basic Templates section to manually design the layout.
%L \
\,&
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Employee Salaries By Department U

Data Model  Emp_Dr q

Create Layout %\/
Basic Templates %\

Blank, Blank, Header and Header and
{Porkrait) (Landscape) Footer Footer
[Portraik) (Landscape)

Shared Templates

ba| |ha| ha| (bha| o

COracle COracle Farm Chart Chart and Dashboard
Zonfidential - Letter - Table
Landscape Partrait

N\
&

Note: It is a good practice to u@uilt templates for reports because:

)

They encoura stent look and feel for layouts
They make ;e%uthors much more productive by taking care comment of elements like headers and

footers. . \3\

However, h
D

3. Trﬁs\/%s‘blank page (portrait) in Layout Editor . Click Layout Grid to insert a grid.
%Q \
\,&

portrait is being used to show how to create a template from scratch.
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[P | 3% g | i | Insert I Page Layout |

Components Fage Elements
IE EH Data Table [ﬂﬁ chart [EH Pivot Table # Page Break Page Mumber
E“{] Repeating Section e} Text [tem €D Gauge @ Image E—jj Total Pages %\/

50 100 150 ZEIFEI 250 300 3|5[I 400 450 EEIFEI %\

o
In the Insert a Layout Grid screen, enter 2 as th{@ber of rows and 2 as the number of columns for the grid. Click

OK.
R

Insert a Layout Grid (%]

Columns |2

Help ] Cancel

v

(ou will add various report components such as charts, tables, and pivot tables in the the grid rows and columns in
the next subtopics.)

: \' Note: Using Layout Grids to control pixel perfect placement of objects in the layout is a best practice.

4. The layout grid with 2 rows and 2 columns is added:
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DO RED B [ iosen [Traeisan|

Components Page Elements
&8l Layout Grid B pataTable [ill chart ERpivotTable | [ Page Break [#] Page Number
f""ﬁ Repeating Section b Tewt Item €23 Gaugs Image Tota Pages \,
250 300 350 400 450 can S50 &00 G50 F00 FED =10 B50 )

b

O~
Now, merge the cells in the second row. Use <CTRL> key to select both the (@ the second row of the grid,
(when the cells are selected, the color turns yellow) click Join Selected E ption available in the Layout Grid

menu. 0\%

b T I !age Ea?w! I Layout Grid Cell |
i Alignment Insert Delete JoinUnjoin
1 |
a ] fo Delete Row ED nin Selected Cells
L

4? Delete Column | *T Unjain

&00 650 Fo0 750 OO B50

Wos&@}gwith Charts
&7

\: 5. Select the first cell in the first row of the grid layout, and click Chart from the Insert menu in the ribbon.
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$ED @

[Freer | Fecetorort | everGcal |

Companents Fage Elements

1t Grid B Data Table

Eﬁhart EH Pivot Table H Fage Break Page Mumber

Gauge Image @ Total Pages

00 350 400

450 500 550 &00 650 oo 75

This action inserts a chart template with prompts as shown below:

&

RED E-

&

v | Chart
Chart Types Chart Styles Effect Filter o/
B ¥ Filter
e - 17 Manage |
300 350 400 450 500 ] &00
)

| Drop Value Here

| Drop Label Here

| Drop Series Here

by
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6 . From the Data Source pane on the left-

Select and drag the SALARY element to the Drop Value Here prompt in the empty chart
Next, select and drag the DEPARTMENT_NAME element to the Drop Series Here prompt.

5l Data Source D@ HED® [T e
B-B 6.1

(= [£3 DATA_DS Select ‘ ChartTypes | ChartStyles

. g DEPARWE."JT_MAME\\ [y select - -l (£ p—

. [E Hme_Date il PEOETS

- [ EMPLOYEE_NAME ‘*““’3'5\' ( Manag
\ 100 200 250 300 350 400 agr

Egﬂ Al ARY

[ -
|Drnp Value HE-.:? | | Drop Series Here |

-! Drop Label Here |

\v
This would populate.thﬂ\tlart with some sample data.

S

\



&
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350K

300K

250K

200K

150K

100K

S0EK

P Administration
B Marketing

B FPurchasing

Human
.Resnurces

FShipping

mT

wo Public
Felations

W 5ales
P Executive
Finance

P Accounting

SALARY %

Q

7 .Next, change the Properties of the SALARY element in the Q&O average the value.

To do this, first select the SALARY item in t
Formula, and select Average from the drop-dow

N

Select

h Select -

1

3
SALARY

300K

Qe
\

4

Surnrmakion

x Delete -

Formula

-

Mo Formula

Blank, Textk 3

Zounk

Counk Diskinck
Surirnation
Averade
Maxiﬂ:il]n

Minirmunm

/\<<Sﬂ1e chart changes to reflect the average salaries by department.

hﬁan, then click the drop-down menu next to Summation under
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24K

20K

1ak

12K

gk

4K |

0k

P Administration

B Marketing

P Furchasing %\/
Human '\,
.Resources %
I Shipping qq
BT %Q
Public /\
rReIatiuns %
W 5ales b‘
P Executive %%
I Finance @
P iccounting :\

You can leave the default style for the chart or select from the@ported chart styles.

(o N\

¥ Filter

Convert

EH Pivot Table

¥ Manage Filters %] switch series an

Default

ln

Earth

¢ il

¢\<(, Gray

4

LB

Autumn

g
=

Comet

Confetti

il ol

Finandial Glass

bt ke

Mautical

.I;'n:;jec.f.

& dn WW

Southwest

Spring

: .I:'-'\.Ega&a

To add a title for the chart, first, Add a row above this chart in the grid layout. Select any of the the grid cells in the first



&
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row, and click the Add a Row Above icon.

Insert TPagELamet ] Layout Grid Cell |
Select Font Alignment Insert Delete

by Select~ ||Custom ™ Custom ~ Lf_.J = i = @ Fifg Delete Row
B
350

& Delete Column

Rogete~ | B 7 U & B L%J | ”

5D 100 150 200 250 300

[%a)

400 450 5

30K |
v\)

Now select the cell right above the chart, and click Insert tab , and then@ext Item.

e

(@2
J Insert I Page Layout I Layout Grid Cell |
Components Fage Elements
Layu:uut Grid EH Data Table mchart EHrivot Table H Fage Break Page Mumber

E%Repeaﬁng Section L‘EjTenﬁm E‘Gauge Image @Tutal Pages

50 100 150 200 250 300 350 400 450 500
o\\\
8 .Next, add a t'g&e chart.
Doubl the text item to select it, then click again to edit it.

3§(\\/ Delete the default text and type Average Salary by Department as the Title.
Select the text and choose Tahoma as font, 12 as the font size, and Bold as the style.

\
/\éJ Center the title by clicking the Center Alignment icon.
’
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J Insert I Page Layout I Text |
Select

Fant Alignment | Page Mumber | Date & Time Link
[} Select - ITahI:nma *|12pt 'I
E H Q |L #
Xowee- [B]Z[UE & & |EF(= Q
50 100 150 200 25 300 350 400 450

>
. «°>Q

Average Salary Department %

9 . Click Save As icon in the toolbar, and save the Layout as Departmen@ies.
A\
- |@@|ﬁ.tm|@@@|aa@

\ \ N
N

Save Template

Template List

< W) w) <

Test [xpt] TestRTF [rtf]

Test2 [rtf] Untitled [xpt]
Charts&Table [xpt]
Tamplate Name: |Departmental Salaries |

SEVEH-.-, Cancel
\ b

10 Return to complete the layout in the Layout Editor.

Now, select the cell beside the bar chart that you have inserted. Follow the above steps to insert a Pie chart
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The steps are briefly listed here:

Select the cell beside the chart that you have inserted, and then click the Insert tab. Click Chart.
To change the chart type to a pie chart, expand the Chart Types menu.

1.
2.
3. Select the Pie chart to insert an empty pie chart with prompts in the grid cell.

é}
N
??O

ﬁ:l | b | Insert I Page Layout I Chart |
Chart Styles

Effect Filter Convert

T Filter

Chart Types
B3 Pivot Table

Area =

-

zPSFFEP

Bar =
Bubble =
Line =

Pie =

Circular =

3D Graphs =

Q)

Pie-Bar

Q0
QO

Multiple Rings

Pie

Multiple Pies Ring

Ring Bar

A4
To populate your pie chart: From the %Source pane, select and drag SALARY to Drop Value Here, and
select and drag DEPARTMENT __ Drop Series Here
Add Percentage Salary by D ent as the Title.
Use Tahoma as the font, 1 size, and Bold as the style. Align the title in the center.
Click Preview icon,and seleﬁPDF from the drop down list to preview your chart :

o0

PN~

D@ XEDI|e

| Insert I Page Layout |

g

2l

Lavout Grid

ﬁﬂ Repeating Section

3

ahe: 7

50 100

o

Aver

= A

Interactive o]
HTHL
POF
RTF

5

Excel 1

PowerPaint
PowerPoint 2007
il FO

il xSl

il xPT

partment

The preview should now look like this:



R R I'TE C »,#209,Nilagiri Block, Adithya Enclave @8801408841 , 8790998182

Average Sala Department
9 ry by Percentage Salary by Department
LT
0.54320%
R 2008% 2.7T0%
- m'd'm;"" " 7530% 3,638% o
] B Adminisirabion
[ Purchasing BATS 4 D.8487% &
B Humn Fusourcas f B Purchasing
=SMIP|I'IG TSN [l Human Rescumes.
T P
. Shi
[ Public Relations = = pra
W Sales [ Public Relations
B Expcutive B Salos
Finance: -
4708% B Excoutive
B Accounting 1401 — Finance
’ Agzoun
44.40% e

N
Click Save icon in the toolbar to save the changes to the Departmental S@y layout.

Adding a Data Table to the Layout @cbcb
&

1. Select the lower row (which has the cells merged). Q\:b

Click Insert tab. Click Data Table to insert the dat
<\

Insert I Page Layout I Layout Grid Cell

Components

Layu:uutGriu:I EH pata Table H]ﬁchart EHPivot Table

le component into the layout.

. V
. \\\
2. Select and dr. ements in the following order from the Data Source pane to the [Drop a Data Item Here] area
of the table ’%
%BPARTMENT_NAME

f\/Q EMP_NAME

HIRE DATE
\ SALARY

’\<<’ As you drag an element, position each successive item directly to the right of the previous element and release to

N
&

create each column.
After you insert all the columns notice that a Grand Total row is automatically inserted .
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DEPARTMEMT MAME EMPLOYEE MAME HIRE DATE SALARY

Administration Jennifer Whalen 193 7-09-17T00:00: 00,000 +05: 30 4400
Marketing Michael Hartstein 1996-02-17T00:00:00.000+05:30 13000
Marketing Pat Fay 1997-08-17T00:00:00,0004+05:30 5000
Purchasing Den Raphasly 1994-12-07T00:00:00, 000+05: 30 11000
Purchasing karen Colmenares 1999-08-10T00:00:00, 000405: 30 2500
Purchasing Alexander Khoo 1995-05-18T00:00:00, 000+05: 30 3100
Purchasing Shelli Baida 1997-12-24T00:00:00, 000+05: 30 2900
Purchasing Sigal Tobias 1997-07-24T00:00:00, 000+05: 30 2800
Purchasing Guy Himuro 1993-11-15T00:00:00,000405:30 2600
Human Resources Susan Mavris 1994-065-07T00:00:00,0004+05:30 &500

654400,

3. Click Preview in PDF icon in the toolbar to preview the layout - @Q}

\Y
QO

<’
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Average Salary by Department

20K |

16K |

126 |

SALARY
DEPARTMENT NAME HIRE DATE SALARY
Adminisiration 1GET-04-17TO000-00.000-07-00 4400
Marketing 1EB8-02-17T00-00:00.000-08-00 13000
Marketing 1007-08-17T00-00:00.000-07-00 €000
Purchasing 1004-12-07T00-00-00.000-08-00 11000
Purchasing 10E5-05-13T00-00:00.000-07-00 00
Purchasing 1EE7-12-24TO0-00:00.000-0E-00 2500
Purchasing 1897-07-24T00:00-00.000-07-00 2800
Purchasing 188B-11-15TO0-00-00.000-08-00 2600
Purchasing Karen Colmenares 1GEE-08-10T0000-00.000-07-00 2500
Human Resources Susan Mavris 18B4-08-07T00-00:00.DO0-07-00 B500
N
Click Save to to save the@ mental Salaries layout.
L]
Note: You can editt@@yout that is saved in one of the following ways:
1 Clig@ﬂ and select Edit Layout in the view mode of the report
2. the report in Edit mode (click Edit link below the report in catalog page) and select the layout to be

>

&°
Q\\\' Formatting the Data, and Working with the Page Layout Features

Layout Editor enables you perform many formatting tasks such as -

dited in the Layout section, and click Edit (pencil icon)

Change the back ground, text colors, and other text attributes

Apply number formats

Define groups/totals/ subtotals, and sorts
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Apply conditional formats

° Define page layout using headers, footers and page breaks.

Note: Most of the above formatting tasks can be done using the options in the menu ribbons. The most

more fine grained properties, you can use the property pane on the left.

commonly used formatting properties are found in the context sensitive menu ribbons on the tool bar. For '\/

1. Changing Background, Text colors, and other Attributes :

In the table select a column header, for example DEPARTMENT NAME.

From the menu ribbon, change the properties as below:
Font to Arial, Font Size to 10, and Font Weight to Bold.

'@ = | 3@, Llj ﬁ:l | 8 | Insert I Page Layout Table Column Header

[s select - |":"ri3| Tjifpt v

Select Faont Alignment

ﬂDeletE * -EIH & % |§|§|§
P

Grouping

Mo Grouping ~

@U

2 . Click Background Color icon from the properties listed in t Qppearance section. Select a color (light blue is
selected in the example here) from the Color Picker s% d click OK.

&



&
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| “Insert | "Pagelayout | Table
Select Font
D‘; Select = | Tahoma ~lgpt -

W Delete - ||B|F | U @/
Color Picker ® %\

Choose 2 color  |cfenft Q
| [ Last Used Color | %\0)

[ Default Color

HOEOOOO (boo

SECELLT X
OEEN Q
IEEEEERN (bcb

T Q

HEEEEEREE ’b{%
Custom Color... Q\'

OK. || Cancel ’b
1
&

Similarly, click the Font color ic ighlighted in the screen) to change the text color for this column header. Select a
color (like Dark blue) from ti@ r Picker.

Change the backgrou% text colors for all the column headers in-line with the DEPARTMENT_NAME.

Hint: Use the < % and <SHIFT> keys to select the remaining columns headers, and change the background and
text colors to e colors you used for the DEPARTMENT NAME column header. Similarly, select the column
footers (t nd change the colors .

N(}R@h\e Properties pane (on the left) changes accordingly:
%L \

4
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=] Properties

E Font
Color ]
Font Family Arial
Font Size 10pt
Faont Style Mormal
|Fant weight Bold |

Text Decoration

B Appearance
Background Color
Border Bottom

Border Left
Border Right
Border Top
Padding

Text Alignment

Vertical Alignment Top

B Misc
Label

Similarly, apply same formats as above to the fo
3. Change the all the column (data cells) fonts to A

Click Save to to save the Departmental

s

[
1px solid =777777 @

ipx solid 2777777 @
ipx solid 2777777 @
ipx solid 2777777 @
2px 4px 2px 4px B2
Left

Mone

oter,

ol

Q
>

ith size 10.

layout.

g}rotals row).

S
The table should appear like this after th m formatting changes:
X

DEPARTMENT NAME EMPLOYEE NAME HIRE DATE SALARY
Adminiztration Jennifer Wihalen 1987-08-17T00:00:00.000+05:30 4400
Warketing llichael Hartstein 15%6-02.17T00:00:00.000+05:30 13000
Marketing Pat Fay h 1997-06-17T00:00:00.000+08:30 8000
Purchazing Den Raghasly N 1994-12-07T00:00:00.000+05:30 11000
Purchaszing Karen Colmenares 155%.08.10T00:00:00.000+05:30 2504
Purchasing Alexander Khee 1995-05-18T00:00: 00.000+085:30 3100
Purchazing Shell Saita 1987-12-28T00-00:00.000+05:30 2500
Purchaszing Zigal Tobias 1557-07.24T00:00:00.000+05:30 2804
Purchasing Guy Himura 1998-11-15T00:00: 1. 000+08:30 2800
‘| Human Resources Susan Mavriz 1994-06-07T0000:00.000+05:30 500
GE4400

You can also modify the other properties such as Text Alignment. Ensure that the data in the numeric columns - such
as SALARY is justified to the right .

4 . Adding Number Formats:



&
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You can add appropriate formats to the numeric or date columns such as SALARY, YEAR, HIRE DATE etc.

To change the format for SALARY, click anywhere below the column header in the data area to select SALARY
column. From the Data Formatting drop down list, that is displayed in the ribbon, select $1,234.57 (Currency) as the
format.

Data Formatting Grouping Formula Sort Conditional Format '\/
(51,234.57) = | |Mo Grouping =| | Mo Formula - @ &B ﬂl@ %Highlight %'&
one (Unfarmatted) 2unning Total =|| 52 Manage Form q%
L . EE0 &00 &50 Fo0 750 Q
_.1I23_1.I5:|" :Numberjl TR TR T NN TN RN TN N NN TN TN RN TN NN TN NN TN NN (NN TN TN TN T A «%
-12% (Percent) [SALARY b‘ \
)

|(51,234.57) (Currency)
i -51,234.57 ATE | SALARY
17T00:00:00.000+05;20 24.400.00

17T00:00:00.000+05:30 213,000.00

17T00:00:00.000+05:30 26,000.00
| 07T00:00:00.000+05:30 211,000.00
1 T9700.00.00 000020 2 c00.00
§ 12T00:00:00.000+05:30 23,100.00
i Z4AT00:00:00.000+05:30 22,500.00

Similarly, select the same format for the 9@ otal (last row). Click Save icon to save the changes to the Layout.

Now, adjust the decimal places to @ Click Move Right twice to remove the decimals in Salary column and the

Totals.
S
Data Formatting %\O

(61,234.57) ~ .

AN

I I
oo A EE !

\*b
9,
The Hould now look like this (observe the formats for Salary column):

&



/\
N
&
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&

. Similarly, click HIRE DATE column and apply the appropriate date f@.

DEPARTMENT MAME | EMPLOYEE NAME HIRE DATE SALARY
Adminizstration Jennifer Whalen 15987-09-17T00:00:00.000+05: 30 24 400
arketing Kichael Hartatein 1598-02-17T00:00:00.000+05:20 213,000
lMarketing Pat Fay 1597-08-17T00:00:00.000+05:30 25,000
Purchasing Den Raphashy 1954-12-07T00:00:00.000+05:30 211,000 r\/
Purchazing Karen Celmesnares 1555-02-10T00:00:00.000+05:20 22,500 D
Purchazing Alexander Khoo 1555-05-12T00:00:00.000+05:20 23,100
Purchasing Shelli Baida 1557-12-24T00:00:00.000+05:30 22,500
Purchazing Sigal Tokiaz 1557-07-24T00:00:00.000+05:20 22,800
Purchazing Guy Himuro 15958-11-15T00:00:00.000+05:30 22 600
Human Rezources Zuzan Mavriz 1954-05-07T00:00:00.000+05:20 25,500
$ﬁﬁl\:1§4m

SE

rm't] Column Q_/

Data Formatting Grouping Formula Sort
Mone * | Mo Grouping = | Mo Formula > @ Qm QIE
M (Unformatted

ne (Unformatted) Funning Total *
55|-[l GI:Ii[I GEIEI
SALARY
ATE
17T00:00:00.000+05:20
7/27/10 (Date) [17700:00:00.000+05:20
Jul 27, 2010, 17T00:00:00.000+05:20
Tuesday, Ju27, 2010 07T00:00:00.000+05:30
10T00:00:00.000+05:30

{7127/10 10: 33 PM (Time) K 5700.00:00.000+05:30
Jul 27, 2010 10:39 PM

- c.
Tuesday, July 27, 2010 10:39 PM 24T00:00:00.000+05:30

The table looks like this:
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DEPARTMENT HMAME EMPLOYEE NAME HIRE DATE SALARY

Adminiztration Jennifer Whalen Sep 16, 1587 24 400

arketing Wichael Hartztein Feb 16, 15955 13,000

Marketing Pat Fay Aug 18, 1857 25,000

Purchazing Den Raphashy Dec g, 15954 . 211,000 @/

Purchazing Karen Celmenarsz Aug S, 1555 L\}b 22,500 %’\o

Purchazing Alexander Khoo May 17, 1555 23,100 %

Purchazing Shelli Baida Dec 23, 1997 22,500 >

Purchazing Sigal Tekiaz Jul 23, 1557 22,800

Purchasing Guy Himuro Mov 14, 15583 22 600

Human Rezources Suzan Mavriz Jun &, 1554 556,500
$684,400

6 . Defining Groups/Totals, and Sorts:

In the table you can add groups, totals, and sorts.
Click the data in the DEPARTMENT NAME column to select the , and select Group Above from the Grouping
drop-down list that appears in the Column menu. Q/

AN

AN
 Pagelayout | Column |
Font Alignment Data Formatting Grouping
S vjeot - = l=]| Format Custom - | Mo Grauping =
B |B |_3- |E & % |= = Mo Grouping
100 150 200 250 00 350 4 Group Left
L L Grnup.ﬁ.bwa\[b
DEPARTMENT NAME EMPLOYEE NAME HI
Purchasing Den Raphashy De
Purchazing Alexander Khoo Iia
Purchazing Shelli Baida De
Purchazing Sigal Tebiaz Jul
Purchasing Guy Himuro Mo
< Purchasing Karen Colmenarez AU
‘G:an.d Total Gi

&%L
D
]

Note: Instead of using menu options, you can also drag DEPARTMENT NAME out of the table and drop it just above
the table to add a repeating group.

A total for the grouped column is automatically added at the end of the group in the table:

Change the font, style, background and text colors as appropriate for DEPARTMENT NAME from the menu options
in the ribbon.
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The table should appear like this after you defined a group on DEPARTMENT NAME column, and applied

appropriate formats:

DEFARTMENT MAME 4

EMPLOYEENAME  [WREDATE  [sAaRy
Den Raphashy Dec 05, 1554 211,000
Alexander Khoo Iay 17, 15985 23,100
Zhelli Baida Dec 23, 1997 82,500
Zigal Tebias Jul 23, 1887 2,300
Guy Himuro Mov 14, 1583 22 600
Karen Celmenarez Aug 09, 1959 22 500

O e e T

Note: Every time you make changes, do not forget to click Sa@&!fsave the changes to the template.

o

7 . Click Preview in HTML icon to see the data in HT! IQQJ

Average Salary by Department Percentage Salary by Department

4K
as4m
2HEE% 2 TR
20
Hrrantr T5¥N IR
- md W 2 dmnistration
W Maketing b 08IT% r
18H .Nchﬂnn; .:::‘.m'q
B Homan Pegur et 2285% hasing
B Shicpeg Il Human Regorces
L :gu-: fratabons ="
W Sales W Pubbc Relations
BH B Executive W Sales
B Fnance 4206% ;f_m
W Accouriing 1481% T
At a4,45% -
o st
SALARY
‘ &
EFARTMENT NAME Administration
,\é’

Scroll down to see the table:
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DEPARTMENT NAME Administration

DEPARTMENT NAME

Marketing

Michas! Hartztsin | Feb 16, 1996 [ 513,000
PatFay Aug 15, 1987 6,000

DEPARTMENT NAME Purchasing

Den Raphaely Dec 06, 15994 £11.000
Karen Colmenares Aug 09, 1555 52,500
Alexander Khoo May 17, 1985 53100
Sheli Barda Dec 23. 1997 22,900
Sigal Tobias Jul 23, 1987 S2.800
Guy Himuro Mov 14, 1958 52,600

8. You can also define sorts on th

™
X:ns in the table. You can define an ascending or descending sorts on columns.
Select the data in EMPLOY

ME column and click Ascending Order (A-Z) icon in the Sort menu. The products
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] Page T;a.?.bl:lt.j Column | Return | @ @ | g ﬂ Eﬁ | @ @ E
Font Alignment Diata Formatting Grouping Formula Sort Conditio
v | Arial -t S Format Custom = | Mo Grouping =/ | Mone = ol | Bhig
-lBlzIUE &R |EE= A U *‘"9’
II:IH:I 15|I:I ZIZIH:I ZEII:I 3I:|'ﬂ 3|5I:l 4-L'|H:I 45|[I 5I:Il[I 55|I:I 'EIZIH:I
Ll 1] l ] 1l l Ll l 1 ] Ll 1] 1 Ll 1l l 1 1l l ] 1 l Ll Ll 1 ] l 1l 1 Ll 1] l 1 1l l ] 1 l ] Ll 1 ] Ll 1l 1 Ll I)
7_513rt_ Grm.l;mg - DEPARTMENT MAME
DEFARTMENT MAME DEPARTMENT NAME
EMPLOYEE NAME HIRE DATE SALARY
[ten Raphashy Dec 06, 1554 11,000
Alexander Khoo May 17, 1555 53,100
Shelli Baida Dec 23, 1997 52,500
Sigal Tokias Jul 23, 1997 32,800
Guy Himuro MNow 14, 1558 52,600
Karen Colmenarez Aug 09, 1959 52 500
Grand Total 524,900

)
A portion of the data table, the data for the Purchasi@artment is shown below, note that the data is sorted by

Employee Name:

DEFPARTMENT NAME F'urcil?ésing
EMPLOYEE NAME HIRE DATE SALARY
Alexander Khoo Maw 17, 1585 23,100
Den Raphashy Dec 08, 1554 11,000
Guy Himuro MNow 14, 15955 22,800
Karen Celmenares Aug 09, 1555 22,500
Shelli Baida . Dec 23, 1557 32,500
Zigal Tobias by Jul 23, 1887 82,200
Grand Total $24 900

\D “
)&D&an also sort by salary, in which case a numeric sort is applied as appropriate.)
Y
\’\<<4 Applying Conditional Formats:
’

which employees are not earning so well (say less than 3000 USD).

To apply simple conditional formats on SALARY select the data in the column and from the

Conditional formats help you to highlight the data in fields based on a condition. For example, you may want to do a
pay revision to reduce attrition rates, and may want to see which employees are earning very good salaries, and

Conditional Formatting



R R I'TE C »,#209,Nilagiri Block, Adithya Enclave @8801408841 , 8790998182

menu, click Highlight.

DheEwREEBE Bod

uping Formula Sort Conditional Formatting
ouping ~ | one - | S8 %Hig%ht @/

Subtotals Priority| = | 5d”Manage Formats

450 Loo 550 600 B50 F00

SN

SALARY
33,100 b‘Q

L)
—_
—_
(==
(==
[==)

“
%
&

10 . In the Highlight screen that appears, select is less than or.@ to from the Operator drop-down list. Enter 3000 as
the Value. Set Bold as the Text style. \fb

Click the box beside the Background Color field. <<,Q
O\

Highlight

Data Field | saLary v|

g Operator I is less than or equal to VI

Vee @ [z00_] o

M

Font Family | v|i_3' |u
;

Color

Background
Calar '{F_")

/\éJ Preview

Value 123

Ok Cancel
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In the Color Picker, select Red as the background color. Click OK .

Color Picker o

Choose a color foooo | [

| B Last Used Color |

[ Default Color

HOBROOOO
OoomOoonOon
OONOBE M
ONECOENEN
EEOEEN
EEEEEEN

EEEEEEN Q\

EEEEEE

Custom Color... @

a Cance Q
e

This takes you back to the Highlight definition di review how conditional format looks like and click OK.

Ve

Highlight

Datz Field | saLany v|

Operator | iz less than or equal to w |

Value @ (3000 O

Fu:untFamih,f| V||B |f |H

Color

Background | N

Colar

,\éJ Preview
N

&

CIK” Cancel
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11 . Define two more conditional formats as given below:

1. One with the Operator - is greater than, and enter the Value as 9000. Apply Green as the back ground colgf, and

set Bold as font style. (See the screens below).
Click OK. %»

Highlight O)Q
Datz Fiald | SALARY v| %\

Operatar | is greater than w |

Value @ 5,000 O Q

Font Family | v |B/|7]|lU

Color

Background |

Colar

Previews

OKl]. Cancel

L

D
2. Also define a \ional format with the Operator - is between , and enter the Values as 3000 and 5000 . Apply
yellow as't ‘@e und color, and Bold as font style. (See the screen below).

Click OK.
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Highlight
Data Field | saLary |
Operator |is between V|

Value 3000 %
* B K
and %0)

@ [s000 O

antFamih,r| v||B|j’ |u b‘
o
Color @

packroind Q>
¢ 5
review )

Value 123

OKl-l Cancel

Click Save icon to save the Depar@ Salaries template.

\
12 . Click Preview in HTML i gfee the data in HTML ( a portion of the table data is shown below, note that all the
three conditional formal ou defined are applied on the SALARY column) .
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DEFPARTMENT NAME Administration
EMPLOYEE HAME HIRE DATE SALARY
Jennifer Whalen Sep 16, 1987 54,400
Grand Total 54 400
\
DEFPARTMENT NAME Marketing
EMPLOYEE HAME HIRE DATE SALARY
Michael Hartztein Feb 16, 1596
Pat Fav Aug 18, 1987 56,000
Grand Total £19.000
DEPARTMENT NAME Purchasing
EMPLOYEE HAME HIRE DATE SALARY
Alexander Khoo May 17, 1555 53,100
Den Raphashy Dec 08, 1554
Guy Himuro Mow 14, 1558
Karen Celmenares Aug 09, 1555
Shell Baida Dec 23, 1957
Sigal Tobiaz Jul 23, 1597
Grand Total $24 900

.)\&"

Note: Some of the salient fea
here. If you have time, try.e
gauges, images, and

13 . Working wit@ayout Features:

In the Ia?o at you have created with the report components such as charts and table, you may want to add page

Layout Editor that are helpful in creating report templates are briefly covered
imenting with other components , and other features such as section, pivot table,

breal f,each component, and in the table after each year. The next few steps guide you to add page breaks,

he;\/ Zand/or footers to the report layout.
o3

e grid layout , select the second row which has charts. Click Insert, and select Page Break from the

<</< ,Phge Elements section in the menu.

lInsert II Page Layout |
%% Components Page Elements

Layout Grid EH Data Table Lﬂﬂ Chart [ERPivot Table # Pag‘iﬁreak Page Mumber

E'.'.f]REpeaﬁng Section H¢iTextItem D Gauge [EHlimage (=] Tota ages
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Similarly, add a page break in the next row before the end of the section for DEPARTMENT NAME (group). Click

inside the table just before the end of the section.
Select Insert> Page break from the Page Elements section in the menu. (This inserts a page break after each

department data in the table.) f\/

W Start Grouping - DEPARTMENT _MAME 4

DEFARTMENT MAME DEPARTMENT NAME QQO)
EMPLOYEE HAME HIRE DATE SALARY D)
Adam Fripp Apr S 1597 28 200 '
Alana Walzh Apr 23, 15983 $3,100
Alberto Errazuriz Mar &, 1587 _
Alsxander Hunold Jan 2, 1550 35,000
Alexander Khoo May 17, 15585 §3,100
Alexiz Bull Feb 19, 1957 $4,100
Allan McEwen Jul 31, 1986 25,000
Alyzza Hutton Mar 18, 1557 38,800
Amit Banda Apr 20, 2000 25,200
Anthony Cabrio Feb &, 1905 !
$684,400
B
End Grouping - DEPARTMENT _MAME %

™
o
14 . To see if the page breal \@userted at right places, preview the layout in PDF. Click Preview in PDF icon.

Notice the page bre@in the PDF file:
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Average Salary by Department Percentage Salary by Department
24K
B Adminiciation JR— W sdministration
arieting 4
20K e 2866% 2776% Il Marketing
.:Llnhaﬁl'lg B Furchasing
Uman
- W Cecoumes 094575 Human .
ms 27 B5% AEB0UICE
P [ Shipping
12K B Er
o Public
Relafians pp— B Eﬂ::’mi
B I sates 1.461% B =ales
W Executive o
4K Finance Finance
I Accounting H Accounding
Ok SALARY
DEFARTMENT NAME Administration %
EMPLOYEE NAME HIRE DATE SALARY
Jennifer Whalen Sep 18, 1987 $4,400
$4,400

N
Y

Scroll down to see the second page. l\g@page break is inserted after each department data:
N\

s

DEPARTMENT NAME Marketing
EMPLOYEE NAME HIRE DATE | SALARY |
Michael Hartstein Feb 16, 1008
Pt Fay Aug 18, 1907 56,000

$19,000
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15 . To insert page/report header and footers, click Page Layout. This displays all the menu options for Page Layout in
the ribbon. Click Report Header.

j Header Footer Wigw Display Unit Interactivity
I ﬁ Page Headar g tHeader | FH Grid

D Page Footer [=J Report Footer

A report header (place holder) is inserted into the layout. O)Q
Q.

)
px ™ IﬁCunﬁgweEumtﬁ

Paper
LA

Porirait | Landscape

> :

Average Salary by Department Percentage Salary by Department
24K
o i i 2 DEE%
= mﬂ:ﬁ;ﬁlm 7 530% D.5429% W Administration
16K W Purchasing ’ —aTE -] larketing
B Human Resources B4TT% M Purchasing
W Shipging 3.638% M Human Resources
12K | 0.04a7% : ﬁ_hmng
ﬁ ;I;E: restens I285% W public Relations
aK B Execulive 4 206% M Sales
Firanoe dd 49% 14815 || E?-cecum-e
A . Inance
= = W 2ccounting

Al

0K SALARY

Al ARY

Qo
Insert a Text ltem i *e\meader, and double click the text item to edit it. Enter Employee Salary Analysis by
Department as;&port header. Apply appropriate formats for the report header.

Preview t%}\put in Interactive viewer.
o
XY
,\é’ '
&
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Bl B E @ @ & (£ & e EE

24K

20K

16K

13K

BK

0K,

Interactive
HTHML %
POF

RTF

Excel
PowerPoint

PoweerPeint 2007

-

o

#

SL
XPT

Average Salary by Department

B Adminisiration
B Marketing

B Purchasing

B Human Resources
M Shipping

BT

B Puldic Relaftions
B sales

Bl Executive

T Finance

B Accounting

DEPARTMENT_NAME

[aN
Employee Salary Analysis by Department

Percentage Salary by Department

0.6420%
2.966% 2,776%
7.530% 3.638%
B.475% 0,545,
. 22...
42
1.461%
44.45%
SALARY
Accounting

DEPARTMENT NAME Accounting Al
EMPLOYEE NAME HIRE DATE Administration
o Executive
Shelley Higgins Jun B, 1894 Finance
VWilliam Gistz Jun &, 1584 Human Resources

IT
Marketing

Public Relations
Purchasing
Sales

B Administration
M Marketing

M Furchasing

W Human Rescunces
M Shippng

mr

¥ Public Relatizns
M 5aks

B Executive

! Finance

W Accowriting
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Observe that you can interactively select a department to view the data.

Also, when you click the interactive ' v ' shaped icon for each column you can see the MS Excel like, interactive
filtering and sorting features.
AV

DEPARTMEMT_MANE | Accounting M
DEPARTHMENT MAME Accounting
EMPLOYEE NAME HIRE DATE SALARY
W
Sheley Hﬁsﬂm Ascending frflun &, 1594
Wilkam Gi_l;l el etk W &, 1334 58,300
[w] (5elect Alf) S
[#]sheley Higgins ] ] §20,300
[ weitiam Gtz
Page 1of ] Conficdentia Sep 02, 201022:12PM

N*
16 . Similarly click Page Footer to insert a footer in the layout. An icon f@)age footer at the end of the grid.

Insert elements such as page numbers, simple text, time and da@o these columns. An example is given here:

1. First, select the page footer, and insert a Grid figkgle row with 3 columns. Insert text items into each of

these columns.
2. Edit the first column in the Grid in the pa e,Q&ér item so that the text is in the format - " <page no> of
<total no. of pages>. 2$(
3. Double click this text item in the first mh, and click Page Number icon from the Text menu in the ribbon
4. Beside the page number icon that i rted into the Page Header, type "of "
5. Now, click Page Total icon fro Xt menu.
6.

Similarly, insert simple Text 3{ "Confidential" in the second Grid column, and Date and Time in the
third column of the footer.v

The footer should look like thi{\‘&\
A0

pags [#] o5 1£] Confidential B
=
.'\'O‘V
The repor@the headers and footers defined should look like this in PDF:
N

&
D
]
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Employee Salary Analysis by Department

Average Salary by Department Percentage Salary by Department
24K »
B Adminisiration W Adminisiration ’
0.6420%
- ! 2966% 2.776% B Marketing
B Purehasing B Purchasing
m [.9497% Human
r 22 B5% Resources
SHipping I snipping
mT mr
B Cetians A i PH“E:;“
S 1.461% W sales
. . Executie
-
Fmce Finance
B Accounting B Accouning
SALARY
DEPARTMENT NAME Administration
EMPLOYEE NAME HIRE DATE SALARY
Jennider Whalen Sep 16, 1087 $4.400 %
$4,400
DEFARTMENT NAME Marketing
EMPLOYEE NAME HIRE DATE SALARY
Michael Hartstein Feb 16, 1006
Pat Fay Aug 18, 1097 8,000
$19,000
AR
DEPARTMEMNT NAME Purchasi ng
EMPLOYEE NAME HIRE DATE SALARY
Mecander Khoo May 17, 1895 $3.100
Den Raphasty Dec @, 1904
Guy Himurs Mov 14, 1098
Karen Colmenares Aug B, 1999
" | Shelii Baida Dec 23, 1997
Sigal Tobias Jul 23, 1067
$24,900
Page 1 of 6 Confidential Jul 27, 2010722 PM
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Note: If you have time, you can experiment with various elements such as gauges, images etc.

Scheduling a Report 0)0>

This topic guides you through the following subtopics: /\0)

Confirming that the scheduler is configured

Defining Delivery Destinations @(

Creating Scheduled Report Jobs
Managing Job History and Jobs @

Confirming that the Scheduler is Configured
Defining Delivery Destinations %%
Creating Scheduled Report Jobs @
Managing Job History and Jobs

Confirming that the Scheduler is Configured (\:2}

Oracle Bl Publisher Enterprise enables you to schedu orts, and deliver the executed output to various
destinations. Bl Publisher Scheduler is configureds@ part of Oracle Bl Enterprise Edition installation

process. However, ensure that the scheduler % igured properly, before you start scheduling the reports.

1Log in (if not logged in) to Bl Publisher ( \) as a user with Bl Administrator privileges.
. Click Administration link (found at th&right top corner of the Bl Publisher page):

AL\

i) | Administration | Help ~

B Open ¥ | Signe=In As weblogic ¥
N\

Y\
In the Adminisms\l(bqﬁge, click the Scheduler Configuration link in the System Maintenance section

. ] 3 .
ORACLE" BI Publisher Enterprise  al
Administration Home | Catalog E New v BE Open~ | Signed
Eéé Data Sources EufﬁJ System Maintenance
3 @ IDBC Connection @ Server Configuration
@ JMDI Connection @ Scheduler Configuration
@ File @ Su:heu:lula ﬁiagnu:usﬁu:s
@ LDAP Connection
@ OLAP Connection
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2In the Scheduler Configuration page that appears, click Test Connection in the Database Connection section to
. check if the scheduler is configured properly.

ORACLE" BI Publisher Enterprise © | Adm

Administration

Signed In As weblogic ~

System Maintenance
Server Configuration | Scheduler Configuration = Scheduler Diagnostics

Apply Cancel

Scheduler Selection

Scheduler |Q|_|ar"_z b

Quartz Clustering |:|

Database Connection

Database Connection Type | jndi |W

nDI Mame  |jdbc/bip_datasource

Test Connection Install Schema

U

JMS Configuration

o
This should display the following s%g indicating the connection was successful:

\
Administration

Administration > Scheduler Configuration

B
I—ﬁ Confirmation
Connection established succassfully,

System Maintenance

7
No\&& are ready to schedule your reports.
&

\’ Defining Delivery Destinations

E ) Oracle Bl Publisher enables you to setup different delivery destinations such as - Email, Printer, Fax,
WebDAV, HTTP, and other destinations, so that you can deliver your reports to these destinations. This
topic guides you how to set up your Email and WebDAYV destinations using Bl Publisher Administration

page.
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1. Inthe Bl Publisher Administration page, ( you need to login to Bl Publisher with Bl Administrator privileges to
access this page) you see a list of destinations in the Delivery section.
Click Email link in the Delivery section.

Home | Catalog E*Nr:w B Op

J System Maintenance >)Q

géé Data Sources
:-a @ JDBC Connection @ Server Configuration
@ JMDI Connection # Scheduler Configuration
@ File @ Scheduler Diagnostics
@ | DAP Connection
2 OLAP Connection

Runtime Configuration

5;_~‘| Security Center

v @ Security Configuration @ Properties
@ Roles and Permissions @ Font Mappings
@ Digital Signature @ Currency Formats
ﬁn;‘] Delivery [i'j Integration
ﬁ @ Delivery Configuration ng @ Oracle BI Presentation Services
@ Printer
2 Fax

@ E@ail
@y AV
@
\)
N3

2 . In the Email configurati@& that appears, Click Add Server.

N

Administration Home |Catalog | | Mew~ | B Open> | Signed In As weblogic
Administration = Email
Delivery

Delivery Configuration = Printer | Fax = Email WebDAY HTTP  FTP  CUPS Server

&Q/ Server Name Host Port Delete

%% Add Server
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3. Inthe Add Server page that appears,

Enter an appropriate name for the mail server in the Server Name field
Enter the Email server in the Host field

Enter the values in the following fields if applicable—
] General field: Port '\/
) Security fields: User Name and Password @

Click Apply. 0)0>

Signed In As weblogic ~

Administration Home | Catalog Erﬂew B Cpen~

Administration > Email = Add Server
Add Server

Apply | Cancel

General

* Server Name |Oracle Mail | *Hoest |mail.oracle.com |
Port |25 |

Security

Uszrnams | Passweord |

N
Important Note: You must enter a%ue name for each server regardless of the type (printer, fax, email, WebDAV,
or FTP). &\
4. Similarly, you can add.a WebDAV server as one of the delivery destinations. Click WebDAYV link in the Administration
page, and click Add, Sewver.

E rbA propriate name in the Server Name field, and Host for the WebDAV server
e following fields if applicable—

b} q \ General fields: Port
] Q Security fields: Authentication Type (None, Basic, Digest) and Encryption Type (None, SSL).
) ’\/ Proxy Server fields: Host, Port, User Name, Password, Authentication Type (None, Basic, Digest)

&
D
]
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Administration Home | Catzlog | B New ~ BS Open ™~ | Signed In As weblogic >
Administration = WebDAY > Add Server
Add Server
APP|Y| e
General
* Ceryer Name |Oracle LCM | * Host Dracleucm.nracle.cnm|
Port | |
Security
Username | Password |
Authentication Type | Mone | Encrypticn Type | Mone %
Proxy Server
Host | | Port |
Username | | Password |
Authentication Type | Mone |

X
&
v
A )
Creating Scheduled Re\@QJobs
N
N\

1. Login (If nogi@?) to Bl Publisher and go to My Folders> Learn folder in Catalog.

Click le link found under the Employee Salaries by Department report.
N
1 | Location | /My Folders Learn |

Employee Salaries by Department | Last Modified 6/25/10 11:26 AM

Lonlln
’\éJ E 62510 11: 26 AM | Modified By weblogic | Created By weblogic
0

Cpen chnfdule Jobs | Job History | Edit | Morev

Testl | La_Modified 8/25/10 3:03 AM | Date Created 6/25,/10 3:03 aM ||
% Created By weblogic

% Open | Schedule | Jobs | Job History | Edit | Marev

Emp_DM | Last Modified 6/25/10 11:24 aM | Date Created 6/25/10 11:24

E weblogic | Created By weblogic
[ undefined

Edit | Mare™
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2.

¢\

4

&

Note: If you do not see the Schedule link it is likely that you do not have Scheduler privileges or that the Scheduler is
not configured properly.

This displays the Schedule Report Job page.
In the General tabbed page, you can select report name and parameter values (select All as the value f 'B

Department report parameter). 0>

A

schedule Report Job Home | Catalog Ne
=] Dwverview y\
zeneral Created by weblogic Cutputs Qutputl
Feport Mame f~weblogic/LearnEmployee Salaries by Department. xdo Destination
Schedule Start immediately Motification

General | [ Duu:lut\{ S::hedule\[ Motification

Report

I~weblogic/Learn/Emploves Salaries by D | Ck

= Parameters

Department: | All

Marketing
Purchasing
Human Resources
Shipping

IT

Public Relations
Sales

Executive

Finance
Accounting
Treasury
Corporate Tax
Control And Credit

0) \
ck Output tab to define the output options. Ensure that "Use Bursting Definition to Determine Output& Delivery
tination" check box is not selected.

\
Select the following options:

Enter DeptSal as the Name, Select Departmental Salaries from the Layout drop-down list, and select an
appropriate output format as PDF

Accept default values for locale, calendar, and select an Appropriate time zone from the drop-down list
Ensure that the Save Output check box is selected
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General \ Schedule | Notification ™,
Lise Bursting Definition to Determine Cutput & Delivery Destnation
= Qutput
+ X
Mame Layout Formatk Locale Timezone Calendar
DentSal || DensrbnentalSslacias v || POF . |w | English (Urited States) ||| [GMT+05:30] India Standard Time ».,-|| Gragarian ~«»|| %

J

output of your scheduled report) , and Save Data for Republishing option is selected ( ou can later

4 . Also, ensure that the Make Output Public option is not selected (if you select this option, a%e s can see the
y
republish the report with a different layout and output types).

You can also add a delivery destination for the scheduled report. In the Destma@%ctlon select Email as the
Destination Type and click Add Destination.

General »  Output { Sd'1edu]e\{ Matification

[] Make Cutput Public
Save Data for Republishing

E Output
+ ¥
Mame Layout Farmat Locale
DeptSal |Deparh'nental Salaries V| |F'DF V| |English (United States)
= Destination

There are five destination types: Email, Printer, Fax, FTP and Web folder. You can add multiple
destinations as you need,

Destination Type | Email w | Add Destination
W

This shovﬁ%mall section below the Destination section. Add the mail ids in the To, CC, and Reply To fields as
reqwr% 2\ a Subject to the mail, and type the message.
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=l Destination

There are five destination types: Email, Printer, Fax, FTP and Web folder. You can add multiple
destinations as you need,

Destination Type | Email W Add Destination '\/

Email Cutput Al i 0)%\
To q
|L|ser1@nracle.cnm | O)Q
QO

Cc Message
s
=
| | B e fira eme
Attached pls find the
Reply to employvee salary report
|me@nrac|e.cnm | department. ..

Subject

|Empll:u'_-;ee Salary Report |

-
AQ’K/

For adding destinations for scheduled reportsé;{@hould have first configured them in the Administration

Note:

page.
You can define multiple outputs for a sin@eduled job and deliver each to separate destinations. For
example, you might want to deliver a PDF o t ds an attachment to an email to a list of managers. You might
also want to deliver the Excel output of the@k report to a content management server (via WebDAV) at the

same time. . ,\QQ

5. Click Schedule tab to define the s ing options.

%\
Select Run Now option rtﬁmg job immediately. Select the Frequency as Once from the drop-down list.

to
A\

=] Dverview _
General Created by weblogic Dutputs Outputl 3 Gl | Submit
Report Mame [~weblogic/Learn/EmpSalRep. xdo Destination (.:) L\}s
Schedule Start immediately Motification

[ General\{ Cutput ™~ Schedule ' Mofification ™.

El Define Schedule Time

Run Mow (&)

You can also add Email Notification options, (as you have already defined Email delivery destination).



&
&

&
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| General ™| Output ™ Schedule ™ Notification

Motify By Email  Email Address|wmail@nracls.cnm

When []Report completed
[[1Report completed with warnings
Report failed

[P T server[fTTpserver 9] Q°>°>
User Mame | | /\0)
Password | | %

When [C]Report completed v \
[[]Report completed with warnings %%
[Jrepart failed Q
Click Submit to submit the schedule. %Q\
6 . Enter Employee Salaries by Department-Sched as the Job a@dnd click Submit again.
, A\ ,
‘Submit Job (2]
|
Feport freweblogic/Learn/Employee Salaries By Department. xdo
Parameters P_DMAME: *
Schedule Start immediately
CQutput Deptsal
Motification
Report Job Mame |Employee Salaries by Department-Sched | |
Help | Submit [\J Cancel

;XV
\

A message is displayed indicating that the job is submitted successfully. Click OK.



&
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Windows Internet Explorer [$__<|

' "_'l. Job successfully submitted
L]

7 . Scheduling a Report Job to run Weekly: O)Q

Follow the steps 1 — 3 listed above to create this job. In step 4, click Schedule tab, and ;@m following options—
\

Select Weekly from the Frequency drop-down list %v
Ensure that you have entered option to run the report Every week Q%
Select Monday to run the report on every Monday

In the Start and End fields enter the start and end dates for the @ and make sure that the time is 8 am

[ General\{ Cutput ™ Schedule ' Mofification ™. @%%

E Define Schedule Time
@

Every week(s)

on [w]Monday
[JTuesday
[]wednesday
[]Thursday
[]Friday
[]5aturday
[]5unday

Start [Oct 11, 2010 8:00:00 AM |

End [0ct 25 2010 8:00:00 AM |

Cli @nR to submit the job, and after specifying a name for the job click Submit again.

&bct some of the different Frequency patterns available for scheduling the jobs. Note that the Specific Dates
<</< |obtion allows you to create a completely custom pattern to meet whatever calendar requirements you have.

N
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| General ™| Output™ Schedule | Notification ™.

B Define Schedule Time

Fregquency | Once b
Once @

Run Now | Hourhy/Minute
Dai
—_— WEEW 2832 Pl O) )

En nth T}y O)Q
nnua
} A

Managing Job History and Jobs (b

Signed In As a

E Report Jobs
% Report Job Histor

The Report Job History page displ )&n’formation about running and completed report jobs. You can see the report job
that you created in the list as shosgvga\he screen below. ( Note that the job status indicates success). Click the job name
link ( Employee Salaries by De ent -Sched) .

L]
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Report Job History

Home

Catalog

Signed In As web

st Refreshed Wed Jun 30, 2010 08:47:54 AM Pacific Standard Time G @

Tiree Zone weed for filters and display | [GMT-11:00] Midway Ieland, Samoa hs
= Filters 9/
Report Job Name |Contans | v | Start Processing | Equals Or Later v Jun 23, 2010 8:47:48 &Y
Report Fath | Contans | End Processing | Equals Or Earlie %] |
Status | Al |
Search Reset
Report Job Histories
= [4 Total Report Output]
Report Job Name Report Mame Status  Start Processing |End Processing [Owner Scope
Emploves Szlaries by Depart  Emploves Salanss by Depart |47 0&-30-2010 0&-30-2010 | allasic Privats
ment-Shed rent, xdo Sucoees DE126:40 AM |08:25:43am  |MEERE e
S Emploves Salanes by Depart |4 05-30-2010 0&-30-2010 . )
Sched-Testlob e Success (03:19:16 AM  [03:19:19AM  |"eDi00c Private
o 0f-29-2010 06-29-2010 . )
EmpSalRep-Sched EmpSalRep. xdo Success |08:08:12 AM 05:08: 15 AM weblogic Private
N i Draft - Jun 26 2010 2-45-03 (& 0f-23-2010 06-28-2010 . )
Testing with Salary AM.xdo Success |03:42: 18 PM 03:42:33 PM weblogic Private
A4
You can also enter appropriate Search criter] rch for reports or search for the job history for a specific report.

Observe the various search criteria that qu&

>

2 General job information and otherY ecution details are deplayed for the specific report. Click DeptSal (in the Output
. Name column) , to see the sched report output using the Departmental Salaries layout that you created.
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cpost oL Mt
General Information Report Job Execution Information
Report Job ID 1054 Report Job Status o
Report Job Name gy ® Salanes by Deoartment- gy procassing Tme  6/30/10 8:26:40 AM POT '\,
Owner  weblagic End Processing Time &/30,/10 B:26:43 &M POT b
Riesort Name  Emploves Salaries by Department Time Elapsed 3.345 Secands 4
Report Scope  Private
Report Job Schedule  ©/30/10 826338 AM PDT
Active Start Date 63010 8:26:38 AM POT
Active End Date
Ho parameters available
= OQutput & Delivery
ML Data i_ . Republish
Status | Al il
Output Name Template |Format Locale Time Zone Cale,.. [Sta,., Send
N 2 —  |Engish (United | [EMT=11:00] Midway Island,
.Depr\thﬁa Departmental Salaries [PDF States) i Greq...| 4@ ﬁ
M,
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& €4 gl @@ - [ e -

Average Salary by Department Percentage Salary by Department 9/
- 4
B Adminisiration
) OLEAZ5% . Al
296E% LTTEN B Marketing
- e 9 H Purchasing
Human

W Resources g ffuman

[ Shipping I Stipping

Ly

" lu
. Public

B _

W Saes i

B Executive Ee tive

H Freance Flnance

B Accoundng H Aocounting

SALARY

DEPARTMENT NAME EMPLOYEE NAME HIRE DATE SAlL ARY
Administraticn Jennifer Whalen 1987021 7T00:00:00_.000-07-00 4400
Marketing Michae! Haristein 1906-02-17T00-00:00 .000-08-00 13000
Marketing PatFay 1987081 7T00-00:00 .000-07-00 G000
Purchasing D:en Raphasaby 1884-12-07T00-00:00.000-D8-00 11000
Purchasing Alexander Fhoo 18@5-05-18TO0-00:00.000-07-00 3100
Purchasing Shell Baida 1097-12-24T00-00:00.000-08:00 2000
Purchasing Sigal Tobias 1097-07-24T00:00:00.000-07:00 2800
Furchasing Guy Himura 1988-11-15T00:00:00.000-D8-00 2600
P asing Karen Calmenares 1928-06-10T00:00:00.000-07-00 2500

Click Return in BI Puhli@q.

\Y

N\
Note: You can a@%the Republish option to republish the scheduled job with a different layout and output options.

3 Similarl§,eli ’heport Jobs to see the Manage Report Jobs page. This page page displays information about jobs that
. are ed for future dates, and also recurring report jobs. You can pause, resume, edit, or delete report jobs from this
pa

@ Report Jobs

% Report Job Hiil;?y
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B Open~ | Signed In As weblogic ~

Home | Catalog

Last Refreshed Wed Oct 13, 2010 12:30:03 AM Eastern European Time ) @

Select fime zone to view jobs | [GMT-08:00] Pacific Time (US & Canada) w |
El Filters
Report Job Mame | Containg b | Start Time | Equals Cr Later Than ! |
Report Name | Contains w | End Time | Equals Or Earlier Than A |
Status | Al v |
Search Reset
B Report Jobs
& 0
|F‘.Epurt Job Mame |F‘.Epurt Mame |S131L|s
|:||M SalRen-Weeskly ||,r'mwel:uh:ugiu:,r'l_earn,rEmpIu:uyEE Salaries By Departm... ” 9 active
|:||Em|:-SaIRED-Sd1Ed-DaM ||,r'mwel:uh:ugiu:,r'l_earn,rEmpIu:uyEE Salaries By Departm... ” 9 active
|:||Oua|'terl-,' Income Statement ||,."6. Published Reporting/Executive /Quarterly I... ” 9 active

4 Click in the column beside a job namwgect that job .Click Pause to suspend the job. (Observe that the job status

. changes to Paused.)
\
o



R R I'TE C »,#209,Nilagiri Block, Adithya Enclave @8801408841 , 8790998182

Report Jobs Home | Catalog E‘ New v BS Open~ | Signed In As

el R e e T et e e

Last Refreshed Wed Oct 13, 2010 12:43:52 AM Eastern European Time g} @)

Select time zone to view jobs | [i3MT-08:00] Pacific Time (US & Canada) w | \
El Filters >%
Report Job Name | Contains b | | start Time | Equals Or Later Than b | ,,,,,,,,,,,,,,,,,,

End Time | Equals Or Earlier Than w | |

Feport Mame | Contains
Status | Al

Search || Reset

B Report Jobs

& (oo P>
|F‘.eport Job Mame |F‘.Eport Mame '|S1311.|s
I:I|M'a'Sa|REE-".-".-'EEH'J ||fﬁ'wel:uIngicﬂearnfEmplnyEE Salaries By Departm... ” & Active
Quarterly Income Statement ||,|"6. Published Reporting/Executive/Quarterly I... ” B Active

\\
If you want to resume the same, click Resume. Sh&gﬂ, click Delete if you would like to delete the job.

(0%
%,
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Manage Report Jobs Home | Catalog New =% Open ™ | Signed In

Last Refreshed Wed Oct 13, 2010 12:49:25 AM Eastern European Time §ff} @)

Select ime zone to view jobs | [GMT-08:00] Pacific Time (US & Canada) W |

= Filters >;b
i )
Report Job Mame | Contains e | Start Time | Equals Or Later Than w |
Feport Mame | Contains i | End Time | Equals Or Earlier Than ~ |» |
Status | All w |
Search Reset

E Report Jobs

|E 00 [ib]

|F‘.Eport Job Mame |F‘.Eport Mame |S131L|s
|:||M"¢'SEI|REE-"."'J'EEH"{ ||fN'a\'Eb|D§|iE,|‘LEEFI‘|,|"Em|:I|D'5I'EE Salaries By Departm... ” B active

Quarterly Income Statement ||f6. Published Repaorting/Executive /Quarterly L., ” & Active
&

>
. ,\\@*

Summary }6

O
In this tutorial, you have Iearne@ﬁo:
Configure Data ches
Create Data l% based on SQL query
Create g f\b imple reports

Build%Q using Layout Editor
%gg eport Jobs

a Job History and Jobs
Re '\/ces

R
% To learn more about Bl Publisher, refer to additional OBEs on the OTN Web site (can link to a
\, specific set of OBEs on the subject)

Qg\ Credits (Optional)

. Lead Curriculum Developer: Padmaja Mitravinda K.

° Technical Contributors/ Reviewers : Mike Donohue, Nikos Psomas, Pradeep Sharma , Klaus
Fabian, Kasturi Shekhar
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